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Because of the variety of uses for the products described in this publication, 
those responsible for the application and use of this control equipment must 
satisfy themselves that all necessary steps have been taken to assure that each 
application and use meets all performance and safety requirements, including any 
applicable laws, regulations, codes and standards. 
 
The illustrations, charts, sample programs and layout examples shown in this 
guide are intended solely for purposes of example. Since there are many variables 
and requirements associated with any particular installation, RS Automation does 
not assume responsibility or liability (to include intellectual property liability) for 
actual use based upon the examples shown in this publication. 
 
Reproduction of the contents of this manual, in whole or in part, without written 
permission of RS Automation Co., Ltd. is prohibited. 
Throughout this manual, when necessary, we use notes to make you aware of 
safety considerations. 
 
 

 
 

 

Identifies information about practices or circumstances that 
can cause an explosion in a hazardous environment, which 
may lead to personal injury or death, property damage, or 
economic loss. 

 

 
 

Identifies information that is critical for successful application 
and understanding of the product. 
 

 

 
 

Identifies information about practices or circumstances that 
can lead to personal injury or death, property damage, or 
economic loss. Attentions help you identify a hazard, avoid a 
hazard, and recognize the consequence. 

 

 
 

Labels may be located on or inside the equipment, for 
example, a drive or motor, to alert people that dangerous 
voltage may be present. 

 

 
 

Labels may be located on or inside the equipment, for 
example, a drive or motor, to alert people that surfaces may be 
at dangerous temperatures. 

 
Trademarks not belonging to RS Automation Co., Ltd. are property of their respective companies.  
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Read this preface to familiarize you with the rest of the manual. This preface 
covers the following topics: 

• Introduction 

• Who Should Use this Manual 

• Conventions Used in this Manual 

• Related Documentation 

• Using Online Help 

• RS Automation Support 

Use this manual when RSWare Version1.2.1 is used to configure and operate 
CSD5 (Firmware Ver1.21) and KNX3 (Firmware Ver1.10) drives. 

You can find help for RSWare in both this User Manual, and Online Help.  

The following conventions are used throughout this manual. 

• Bulleted lists provide information, not procedural steps 

• Numbered lists provide sequential steps. 

• Words you type or select, and keys that you press, appear in bold 

These publications provide additional information. To obtain a copy, contact 
your local RS Automation office or distributor, or access the documents on-line 
at www.rsautomation.co.kr or http://www.rsautomation.biz/. 

 

http://www.rsautomation.co.kr/
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The following types of online help are available: 
 

RSWare Help  

Select Contents and Index 
from the Help menu. 
Navigate the help files using 
the Table of Contents, the 
Index and the Search tabs 

Descriptions of all on-screen 
object. 
Object property configuration 
settings. 
How to information. 

Context Sensitive 
Help  

Either: 
•Click on a Help button in 
the active window, or  
•Select an on-screen object 
press F1 

For help about the selected 
object. 

Contact your local RS Automation representative for: 

• Sales and order support 

• Product technical training 

• Warranty support 

• Support service agreements 

If you need to contact RS Automation for technical assistance, please review 
the information in this manual or in the Online Help file first. Then call your 
local RS Automation representative. For the quickest possible response, we 
recommend that you have the catalog numbers of your products available when 
you call. 

 

Information on the installation 
of your CSD5 servo drive 

CSD5 Servo Drive Installation 
Instructions 

CSD5-IN001 

Information on the motors 
used together with CSD5 servo 
drive 

Servo Motor User Manual 
SMOTOR-
UM002 

CSD5 User Manual CSD5 User Manual CSD5-UM001A 
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RSWare is a Windows 2000, XP, Vista, Windows 7 application by RS 
Automation that provides a complete setup for the CSD5 and KNX3 drives. 
Use RSWare to: 

• Communicate with multiple CSD5 and KNX3 drives, using your PC's 
serial port. 

• Adjust the drives' feedback loop gains and parameters for the specific 
motors and loads. 

• Define the drives' motion capabilities by selecting the operating modes 
for the CSD5 or KNX3. 

• Monitor a wide variety of status and motion parameters on the drives. 

• Customize the application interface to display only the information you 
wish to see. 

Before you begin using RSWare, read this chapter to become familiar with: 

• Understanding the RSWare Interface 

• Starting RSWare 

RSWare provides a graphical user interface within which you configure your 
drives. The workspace consists of: 

• a Workspace window 

• a Client Area 

• an Output window 

• a Main menubar 

• a set of Toolbars 

• a Status bar 
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Use the View menu commands to enable and disable these RSWare 
 

The RSWare user interface for CSD5 and KNX3 drives, with several features 
enabled, looks like this: 
 

 
 

 
 
 

 
 

 
 

 
 

 
 
 
 
 
 

 
 

 
 
 
 

 
 

The Workspace window is located, by default, beneath the menubar and 
toolbars, and above the Status Bar. Use the F7 key to return focus to the 
Workspace window. 
 
The Workspace window has two main branches: 
 

On-Line Drives 
branch 

All connected on-line drives and their child objects. 

RSWare File 
branch 

All configured off-line CSD5 and KNX3 drives, their child 
objects. 

 

Main menubar 

Toolbars 

Workspace Window 

Properties Windows: 

CSD5 

KN3 
KN3 
KN3 
KN3 
KN3 
KN3 

Client area 

Status bar 
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Use the Workspace window to navigate to all of the connected on-line and off-
line objects and perform the following tasks: 

• Create new Drive. 

• Cut, Copy, Paste and Delete selected Workspace window objects. 

• Open the Properties dialog box for selected Workspace window objects. 

You can resize and move the Workspace window in several ways: 

• With the Workspace window in its default state (i.e., attached to the 
RSWare interface) you can double-click on the Workspace window's title 
bar to detach it from the RSWare interface. 

• Once detached, the Workspace window possesses all the properties of 
any window. It can be resized or moved entirely outside the RSWare 
interface. 

• To return the Workspace window to its default position, just double 
click on its title bar. 

To hide the Workspace window, de-select the Workspace selection in the View 
menu. 

The Client Area is the large gray area located, by default, beneath the menubar 
and toolbars and to the right of the Workspace window. 
 
Use the Client Area to display: 

• Property windows for objects selected in the Workspace window, where 
you can configure the selected object's properties. 

Selecting Workbook Mode from the View menu displays a tab for each object 
in the Client Area. The tab contains the abbreviated name of the related object. 
Select a tab to bring the related object to the top of the Client Area. 
 
Unlike windows, the Client Area cannot be directly resized. The size of the 
Client Area depends upon the size and location of the surrounding Workspace 
and Output windows, the Main menubar, the Status Bar and the several 
toolbars. 
 
However, you can use the Cascade, Tile Wide, Tile Tall and Arrange Icons 
Window menu commands to arrange the display of windows in the client area. 

The Main menubar is located at the top of the RSWare interface. Use it to 
customize the RSWare main window, and to perform essential functions and 
procedures with respect to objects selected in the Main Window. 
 
The main menubar looks like this: 
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The menu items contain the following commands: 
 

File 
New, Open, Save, Save As, Close, Print, Print Preview, Print Setup, 
Import, Export, Upgrade Firmware, Recent File, Exit 

Edit 

Undo, Redo, Cut, Copy, Paste, Delete, Find, Replace, Select All, Go 

To… Corresponding { } ( ), Go To …Line Number, Toggle 

Bookmark, Next Bookmark, Previous Bookmark, Clear All 
Bookmarks, Properties 

View Toolbars, Status Bar, Workspace, Output, Workbook Mode 

Insert CSD5, KNX3  

Tools Customize, Rescan, Rescan Options, Serial Port, 

Commands Enabled 

Window Close All, Cascade, Tile Wide, Tile Tall, Arrange Icons 

Help 
Contents and Index, Tip Of The Day, Release Notes, About 
RSWare 

RSWare offers four standard Windows toolbars, which can be detached from 
the RSWare user interface and relocated. To return a toolbar to its last docking 
position, just double-click on its header bar. 
 
The RSWare toolbars are: 

File New, Open, Save, About, Locate 

Edit Cut, Copy, Paste, Erase 

Enable Enable, Disable All 

 
Use the Toolbars command (in the View menu) to open the Toolbars dialog 
box, and enable or disable existing toolbars, and create new toolbars. 
 
Use the Customize command (in either the Toolbars dialog box or the Tools 
menu) to open the Customize dialog box, where you can: 

• add a command icon to a toolbar by dragging it from the Command tab 
and dropping it on the desired toolbar, and 

• delete a command icon from a toolbar by dragging it from a toolbar and 
dropping it off the toolbar. 
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To display the Status bar, use the View menu Status Bar command. The status 
bar contains: 

• Tooltip help: a description of the menu or button command immediately 
beneath the pointer. 

• Indicators for caps lock (CAP), num lock (NUM) and scroll lock (SCRL). 

• The Row and Column reference for the cursor, if a source file or header 
file has focus in the Text Editor. 

When the status bar is visible, a check mark appears to the left of the Status Bar 
command in the View menu. 

When you start RSWare for the first time, RSWare prompts you to Open Last 
File, xxx.udb, Open existing file, or Create new file. After you select the file 
to open or create, RSWare scans the network for online drives. 
 
You may need to configure your PC's serial port settings (Refer to Serial Port 
Settings on page 13) and rescan the network (Refer to Scanning the Network 
on page 12) to insure that RSWare successfully locates all online network drives. 

RSWare stores the name and location of any open RSWare file in its memory, 
when you last closed RSWare. Each time RSWare opens, it displays a dialog 
box that lets you do one of the following: 
 

Open Last File, 
xxx.udb and then OK 

Opens the most recently used RSWare file. 

Open existing file and 
then OK 

Open another, existing RSWare file of your choice. 

Create new file and 
then OK 

Open a new RSWare file. 

Cancel 
Open RSWare without an active file in the Workspace 
window. 

 
Note: A new file is stored in temporary storage until saved. 

Every time RSWare opens, it conducts a search of the network for all 
connected drives. A Scan For On-Line Drives dialog box appears. This dialog 
box displays RSWare's progress in checking for on-line drives on nodes 0 to 10, 
and the specific task RSWare is currently undertaking (e.g., Scanning Node… 
or Attaching to Node…). 
 



RSWare User Manual 

To stop the process of scanning for - and attaching to - on-line drives, click on 
the Stop Scanning button. 
 
RSWare displays every drive it detects in the On-Line Drives branch of the 
Workspace window. Because RSWare does not automatically update the 
Workspace window, select Rescan from the Tools menu to display the list of 
drives that are currently on-line. 

After you open RSWare for the first time, you may wish to change the 
configuration of your PC's serial port and baud rate settings from the defaults 
of COM1, 57600 Baudrate, 8 Data bits and No Parity. To do this: 

1. Select Serial Port… from the Tools menu. 

2. In the PC Communications Setup dialog box, type the appropriate serial 
port settings. 

You can use the RSWare interface to upgrade the firmware for a selected on-
line drive. Use the Upgrade Firmware…command (in the File menu) to open 
the Firmware Upgrade dialog box, where you can perform a flash upgrade to 
the firmware of a drive appearing in the On-Line Drives branch of the 
Workspace window. Before issuing the Upgrade Firmware…command, be sure 
to first obtain a copy of the new firmware and any related instructions. 
 
To upgrade firmware in the Firmware Upgrade dialog box: 
 

1. Select the drive for firmware upgrade from the list of On-Line Drives. If a 
drive name has been left blank, it is identified as < Drive>. 

2. Enter the pathname of the new firmware file. Either type in the pathname, 
or use the browse button (marked with an ellipsis "…") to navigate to the 
new firmware file. (The new firmware file must have an extension of .hex.) 

3. Select the Begin Load button. RSWare informs you of firmware upgrade 
progress using both a progress bar and status messages. 

 
 

 
 

You can cancel the firmware upgrade during the upgrade 
process by selecting the Cancel button. However, If you 
cancel the firmware upgrade while it is in progress, the selected 
drive ceases to be functional. Thereafter, the selected drive can 
be used only to complete a subsequent firmware upgrade. 
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Use RSWare to configure both an on-line and an off-line drive. You can 
configure an on-line drive, then copy or move it to an off-line RSWare file, or 
configure an off-line drive (in an RSWare file), then copy and paste it onto an 
existing on-line drive, thereby overwriting the on-line drive's settings. You can 
also use RSWare's drag-and-drop functionality to accomplish the copy and 
paste process in a single step. 

 
This chapter covers: 

• Opening RSWare 

• Creating, Opening and Saving RSWare Files 

• Creating a New Drive 

• Importing and Exporting a Drive 

• Working in the Workspace Window 

Before you create a new off-line drive, you must first create an RSWare file to 
contain the new drive. When RSWare opens for the first time, a dialog box like 
the following one appears: 
 

 
 

If you: 

• Select Open Last File:<filename> and click OK, RSWare opens the 
most recently used RSWare file. 

• Select Open existing file… and click OK, the Open dialog box appears, 
where you can navigate to and open a previously saved RSWare file. 
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• Select Create new file and click OK, a new, empty file is created. 

Note: A new file is stored in temporary storage, and the Workspace icon 
displays Unsaved until the file is saved with a filename. 

• Click the Cancel button, RSWare does not open an RSWare file. 

 
RSWare displays the selected RSWare file, if any, in an Off-Line branch of the 
Workspace window. 

An RSWare File is a container that can hold any number or combination of off-
line CSD5 and KNX3 drives, projects and their children. An RSWare File is 
distinguished by its extension of .udb 

To create a new RSWare DataBase (.udb) file: 

1. Do one of the following: 

• Select New in the File menu 

• Click on the New icon in the File toolbar 

• Press the Ctrl + N keys  

 
Note: If an RSWare file is already open, a Save Changes dialog opens and 
requires a response before the request to open a new file executes. Choosing 
one of the following from the dialog opens the new RSWare file: 
 

Yes 
Saves the open file under the filename and location 
previously designated. 

No Discards the changes to the open file. 

Cancel Aborts the new RSWare file, leaving the previous file open. 

 

2. A new RSWare File, titled Unsaved, appears in the Workspace under On-
Line Drives. 

3. The RSWare file can be populated with drives as described in "Creating a 
New Drive" on page 17, and saved under a name using the directions in 
"Saving an RSWare File" on page 17. 
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To open an existing RSWare File: 

1. Do one of the following: 

• Select Open in the menu. 

• Click on the Open icon in the File toolbar 

• Press the Ctrl +O Keys 

 
Note: If an RSWare file is already open, a Save Changes dialog opens and 
requires a response before the request to open a new file executes. Choosing 
one of the following from the dialog opens the new RSWare file: 
 

Yes 
Saves the open file under the filename and location 
previously designated. 

No Discards the changes to the open file. 

Cancel Aborts the new RSWare file, leaving the previous file open. 

 
The Open dialog box opens: 
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2. Navigate to and select the name of the RSWare File to open. 

3. Click Open. The selected RSWare File appears in the Workspace window. 
If the Workspace window had displayed a previously opened RSWare File, 
the selected RSWare File is displayed in its place. 

To save all changes made to a drive or a project: 

1. Do one of the following: 

• Select Save in the File menu. 

• Click on the Save icon in the File toolbar 

• Press the Ctrl +S keys 

To save an RSWare File to a new filename: 

1. Select Save As in the File menu. The Save As dialog box opens: 

 
 

2. Type or select a file name. 

3. Navigate to the location where the new RSWare File should be stored. 

4. Click Save. 

Note: Save As saves the entire RSWare database (.udb) file to a new name. 

With an RSWare File open in the Workspace window, you can add a new off-
line CSD5 or KNX3 drive. 
 
To add a new CSD5 drive, do one of the following: 

• Select CSD5 from the Insert Menu. 

• With the RSWare File selected, click the right mouse button, then select 
Insert CSD5 from the pop-up menu. 

A new CSD5 drive appears as the bottom drive in the Workspace window. The 
name of the new drive is Drive or (if Drive already exists) Drive n, where n is 
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the lowest positive integer that creates a unique drive name for the specific 
drive model.( i.e., Two CSD5 drives may be named Drive and Drive1, and two 
KNX3 drives may also be named Drive and Drive 1.) 
 
To add a new KNX3 drive, do one of the following: 

• Select KNX3 from the Insert Menu. 

• With the RSWare File selected, click the right mouse button, then select 
Insert KNX3 from the pop-up menu. 

A new KNX3 drive appears as the bottom drive in the Workspace window. 
The name of the new drive is Drive or (if Drive already exists) Drive n, where n 
is the lowest positive integer that creates a unique drive name. 

You can import an existing, previously configured drive to an RSWare File 
using the File menu's Import command. 

 
Only drives that have been previously exported, using the File menu's Export 
command, can be imported. Exporting a drive saves it as an User data 
eXchange File with an .uxf extension. 

To Export a drive: 

1. Select a drive branch. 

2. Do one of the following: 

• Select Export from the File menu, or 

• Place the cursor over the select drive branch, click the right mounse 
button and select Export from the pop-up menu. 

The Export to dialog box opens: 

 
 

3. In the Export To dialog box, type or select a name for the drive. 
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4. Navigate to a location to which the file should be exported. 

5. Click Save. The exported file is saved as an User data eXchange File (with 
an .uxf extension). 

1. To Import a previously exported drive: 

2. Either: 

• Select Import from the File menu or 

• Place the cursor over the selected RSWare File, click the right mouse 
button and select Import from the pop-up menu. 

The Import From dialog box open: 

 

3. In the Import From: dialog box, navigate to and select the User data 
eXchange File (.uxf) that contains the desired drive settings. 

4. Click Open. RSWare displays the imported drive in the off-line RSWare 
file. 

You can use the Edit menu commands to Cut, Copy, Paste and Delete/ Erase 
items in the Workspace window. You can also use RSWare's Drag and Drop 
function in place of Cut and Paste. 

The Cut command removes certain selected items from the Workspace window. 
Any item cut from the Workspace window replaces any other item previously 
cut (or copied) and stored in RSWare's clipboard. 
 
The following Workspace window items cannot be cut: 

• The On-Line Drives branch 
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• A drive in the On-Line Drives branch 

• An RSWare file 

• Any child branch of a drive 

 

To cut an item from the Workspace window: 

1. Select a Workspace window item (other than one of those listed above). 

2. Do one of the following: 

• Select Cut from the Edit menu 

• Click the right mouse button, then select Cut from the pop=up menu 

• Simultaneously press the Ctrl +X keys 

• Click on the Cut icon in the Edit toolbar. 

3. RSWare displays a message box asking you if you wish to continue. Select 
OK to cut or Cancel. 

The Copy command copies certain selected items from the Workspace window. 
Any branch or item copied in the Workspace window replaces any other 
branch or item previously copied (or cut) and stored in RSWare's clipboard. 

 

The following Workspace window items cannot be copied: 

• An RSWare file 

• Child branches of a drive. 

To Copy an item from the Workspace window: 

1. Select a Workspace window item (other than one of those listed above). 

2. Do one of the following: 

• Select Copy from the Edit menu 

• Click the right mouse button, then select Copy from the pop=up menu 

• Simultaneously press the Ctrl +C keys 

• Click on the Copy icon in the Edit toolbar. 

The Paste command inserts a previously copied or cut Workspace window item 
or branch into the selected location of the Workspace window. 
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When pasting into the Workspace window, three results can occur: 

• If the selected Workspace window item is of the same type as the item to 
be pasted, the pasted item REPLACES the selected item. 

• If the selected Workspace window item is a parent branch that must 
always have one child of the same type as the item to be pasted, the 
pasted item REPLACES the selected branch's child of the same type. 

• If the selected Workspace window branch can have multiple child 
branches of the same type as the item to be pasted, the pasted item:  

- REPLACES a child branch with the same name as the pasted item, or 

- is ADDED as an additional child branch, if no other child branch 
shares the pasted item's name. 

Any Workspace window item can be selected to receive a pasted item except 
the following: 

• Child branches of a CSD5 drive. 

• Child branches of a KNX3 drive. 

 
To Paste an item in the Workspace window: 

1. Select a Workspace window branch (other than On-Line Drives, a child 
project in Archives, or a drive's children.) 

2. Do one of the following: 

• Select Paste from the Edit menu 

• Click the right mouse button, then select Paste from the pop-up menu 

• Simultaneously press the Ctrl + V keys 

• Click on the Paste icon in the Edit toolbar. 

If you are pasting an item into the Workspace window that replaces 
another item of the same name, RSWare displays a message box asking 
you if you wish to continue. 

3. Select OK to paste or Cancel. 

The Delete command removes selected branches or items from the Workspace 
window. The deleted item is permanently destroyed. The Delete command 
cannot be reversed by an Undo command. 
 
The following Workspace window items cannot be deleted: 

• The On-Line Drives branch 

• A drive in the On-Line Drives branch 

• An RSWare file 
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• An immediate child item branching directly from a drive 

To Delete an item in the Workspace window: 

1. Select a Workspace window branch (other than one those listed above). 

2. Do one of the following: 

• Select Delete from the Edit menu 

• Click the right mouse button, then select Delete from the pop-up menu 

• Click on the Erase icon in the Edit toolbar. 

RSWare displays a message box asking you if you wish to continue. 

3. Select OK to paste or Cancel. 

You can use the drag-and-drop method to copy and move a Workspace 
window branch or item to other locations within the Workspace window. The 
drag-and-drop method combines the Cut, Copy and Paste commands, as 
follows: 

• the drag-and-drop method copies a Workspace window branch or item 
that can be both copied using the Copy command, and pasted using the 
Paste command. 

• the drag-and-drop method moves a Workspace window branch or item 
that can be both cut using the Cut command, and pasted using the Paste 
command. 

To use the drag-and-drop method to copy a Workspace window branch or item: 

1. Place the cursor arrow on a Workspace window branch or item that can be 
copied and hold down the left mouse button 

2. Drag the selected Workspace window branch or item to the desired 
destination. One of two things happens: 

• If the item can be copied, the pointer continues to appear as an arrow 
and a + (plus) sign appears to the right of the arrow (for as long as you 
continue drag the item over a place in the Workspace window where it 
may be dropped). 

• If the item cannot be copied, or if you are dragging the item over a part 
of the Workspace window where it may not be dropped, the arrow is 
replaced by a circle with a line through it. 

3. Release the mouse button when you arrive at the Workplace window 
location where you want to copy the Workspace window branch or item. 
The result is the same as if you had Copied then Pasted it to this location. 

To use the drag-and-drop method to move a Workspace window branch or 
item: 

1. Place the cursor arrow on a Workspace window branch or item that can be 
cut and hold down the left mouse button 
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2. Drag the selected Workspace window branch or item to the desired 
destination. One of two things happens: 

• If the item can be cut, the pointer continues to appear as an arrow (for as 
long as you continue drag the item over a place in the Workspace 
window where it may be dropped). 

• If the item cannot be cut, or if you are dragging the item over a part of 
the Workspace window where it may not be dropped, the arrow is 
replaced by a circle with a line through it. 

3. When you arrive at the Workplace window location where you want to 
move the item, release both the mouse button and the Ctrl key. The result 
is the same as if you had Cut then Pasted it to this location. 

 
 



 

RSWare User Manual 

A CSD5 drive may be set up in one of several operational modes. 

• Analog Velocity Controller 

• Analog Current Controller 

• Preset Velocity Controller 

• Position Follower using an Auxiliary Encoder 

• Position Follower using Step and Direction controls 

• Position Follower Step Up and Step Down controls 

• Indexing Controller 

 
The CSD5 drive interface also provides Homing, Oscilloscope, drive Tuning 
and Monitor capabilities, and Motor and Encoder Diagnostic routines. 
 
This chapter covers: 

• Configuring an CSD5 Drive 

• Understanding the CSD5 Drive Branch 

• Understanding the Analog Window 

• Understanding the Preset Window 

• Understanding the Follower Window 

• Understanding the Indexing Window 

• Understanding the Homing Window 

• Understanding the Motor Window 

• Understanding the Tuning Window 

• Understanding the Encoders Window 

• Understanding the Digital Inputs Window 

• Understanding the Digital Outputs Window 

• Understanding the Analog Outputs Window 

• Understanding the Monitor 
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• Understanding the Oscilloscope Window 

• Understanding CSD5 Statuses 

• Understanding the Faults Window 

• Understanding the Service Information Window 

Each CSD5 drive in the Workspace window has the following child branches 
or windows:  

• Operation Modes 

-Analog 

-Preset 

-Follower 

-Indexing 

-Homing 

• Motor 

• Tuning 

• Encoders 

• Digital Inputs 

• Digital Outputs 

• Analog Outputs 

• Monitor 

• Oscilloscope 

• Faults 

• Service Information 

 
Except for the Monitor windows, all of a drive's child branches can and must 
be configured in a Properties window. 

To configure the properties for an CSD5 drive or one of its child branches: 

1. In the Workspace window, select the drive branch to configure. 

2. Do one of the following: 

• Select Properties… from the Edit menu. 
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• Click the right mouse button and select Properties… from the pop-ip 
menu. 

• Double click on the selected drive branch. 

A properties window, such as the Drive Properties window display below, 
appears for the selected branch. 
 
Note: The Properties window of CSD5 Drive and KNX3 Drive are not same. 
The below is an illustration of CSD5 Drive. 

 
 

3. To configure properties for the selected drive branch, use the features of 
the Properties window as follows: 

Parameters   
Located in the upper left part of the Properties window. 
Type or select values in the parameter fields to configure the 
settings of the selected drive branch. 

Commands  

Located in the upper right part of the Properties window. 
Click a button to issue the associated command. Select show 
Commands, below, to display command buttons. Not every 
drive branch has associated commands. 
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Statuses 

Located beneath the Parameters and Commands sections. 
By default, these fields display the on-line status of the 
selected drive branch. Click on Setup to open a window 
where you can customize the statuses to be displayed. Status 
fields are read-only. Select Show Status to display the status 
section. 
Note: Status values for off-line drives may not be 
meaningful. 

Show Status  Select this to display statuses for the selected drive branch. 

Show 
Command 

Select this to display commands for the selected drive branch. 
Commands can be executed only for on-line drives. This 
selection is grayed-out if no commands are associated with 
the selected drive branch. 

Setup 

Opens the Monitor Setup window, where you can customize 
the Statuses that are displayed. 
Refer to Understanding the Monitor on page 111 for more 
information about using the Monitor window. 

Revert 
Click this button to return parameter settings to the values 
they had when you first opened this window. 

Close Closes the window. 

Help Click this button to get online help for this window. 

The remainder of this chapter describes the process of entering and editing 
drive configuration settings, the statuses that are displayed by default for each 
drive branch when the drive is on-line, and the commands available to a user 
for each drive branch when the drive is on-line. 

The Properties window for the CSD5 Drive branch looks like this: 
 
Note: The Properties window of CSD5 Drive and KNX3 Drive are not same. 
The below is an illustration of CSD5 Drive. 
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Use this CSD5 window to: 

• configure the parameters for an off-line or an on-line drive 

• monitor the status of an on-line drive 

• execute commands that clear faults, reset the drive or reset the 
EEPROM 

• open the Control Panel windows, where you can issue commands that 
control drive motion 

 
You can edit parameters for both an on-line and an off-line drive. However, 
you can monitor statuses (i.e., executed through the RSWare interface) only for 
a CSD5 drive in the On-Line Drives branch. 
 
The following parameters apply to the CSD5 Drive window: 
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Description 
The name of  the drive. 
Note: The drive name is displayed in the title bar of  the windows relating to this drive. 

Parameter - 

Range: up to 32 characters long. 

Default: Drive 

Applicable 
Operating 
Mode 

All 

When 
Enabled 

Immediately 

 

 

Description Select main power input source 

Parameter [Ft – 0.02]- Digit 3 

Range: 

Select Description Value 

Enable. 
 

50~400W drive: Enable single-phase open check 0.8~1.5kW 
drive :Enable 3-phase open check 

0x0 

Disable Do not check the input power 0x1 

Single phase 
input 

Single-phase input 0x2 

Default: Enable 

Applicable 
Operating 
Mode 

All 

When 
Enabled 

Servo-Off  -> Setting 

 

Description 
Set Motor type 
Set three items of  the motor: motor type, motor rated output, and encoder type. 

Parameter [Ft – 0.01] 

Range:  

Default: CSMT-04BR for CSD5 Drive; CSM-A3BB for KNX3 Drive 

Applicable 
Operating 
Mode 

All 

When 
Enabled 

Servo-Off  -> Setting -> After power cycle 

 

Description Direction of  Motor Rotation 

Parameter [Ft – 0.02]- Digit 2 

Range: 

Select Description Value 

Normal 
The command signal is not inverted so that a positive 
command value results in CW Rotation, (as viewed from 
shaft end). 

0x0 

Inverted 
The command signal is inverted so that a positive command 
value results in CCW Rotation, (as viewed from shaft end). 

0x1 

Default: Normal 

Applicable 
Operating 
Mode 

All 
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When 
Enabled 

Servo-Off  -> Setting 

 

Description Select a unit of  measure for position, velocity, and acceleration displays 

Parameter - 

Range: 

Select Description Value 

Metric 

units for rotary motors are: counts (position), RPM 
(velocity), revs/ sec2 (acceleration);units for linear motors are: 
meters (position), meters/ sec2 (velocity), and meters/ sec2 
(acceleration). 

- 

English 

units for rotary motors are: counts (position), RPM(velocity), 
revs/sec2(acceleration); 
units for linear motors are: inches (position), 
inches/sec2(velocity), and inches/sec2(acceleration)., 

- 

User 
displays measurements in terms defined by the user in the 
Units section. 

- 

Default: Metric 

Applicable 
Operating 
Mode 

All 

When 
Enabled 

Servo-Off  -> Setting 

 

Description 
Select the combination of operation modes to be used when the Operation Mode Override digital input is 
active or inactive. 

Parameter [Ft – 0.00] 

Range: 

Select Description Value 

Follower/None Position control mode F(1) 

Analog Velocity 
Input/ None 

Speed control mode S(2) 

Analog Current 
Input/ None 

Torque control mode C(3) 

Analog Velocity 
Input/ Follower 

Speed + position mode SF(4) 

Analog Velocity 
Current/ Follower 

Torque + position control mode CF(5) 

Analog Current 
Input/Analog 
Velocity Input 

Torque + speed  control mode CS(6) 

Preset Velocity / 
None 

Multi-step speed control mode P(7) 

Preset Velocity / 
Follower 

Multi-step speed + position control mode PF(8) 

Preset 
Velocity/Analog 
Velocity Input 

Multi-step speed + speed control mode PS(9) 

Preset 
Velocity/Analog 
Current Input 

Multi-step speed +Torque control mode PC(10) 

Indexing Input/ 
None 

Indexing I(12) 

Default: Follower/None 
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Applicable 
Operating 
Mode 

All 

When 
Enabled 

Servo-Off  -> Setting -> After power cycle 

 

Description 
Initial torque value applied when the servo drive activated. Prevents the downturn of  vertical load during initial 
operation 

Parameter [Ft – 4.06] 

Range: -100~100 

Default: 0 

Units: % of  motor rated continuous current 

Applicable 
Operating 
Mode 

All 

When 
Enabled 

Immediately 

 

Drive - Velocity Limits - Velocity Limit Mode 

Description 
Specifies the method for limiting the motor velocity within the motor's rated maximum velocity. The drive will 
never exceed the motor's rated maximum velocity. This setting can be used to restrict the motor velocity further. 

Parameter [Ft – 2.13] 

Range: 

Select Description Value 

Disabled Motor‟s rated maximum velocity 0x0 

Manual Limit Limited by "Manual Velocity limit" (Ft-2.12). 0x1 

Analog Input 
Limited by Analogue Speed Command Value (except Analog 
Speed Mode). 

0x2 

Manual and 
Analog 
 

Limited by lesser one between "Manual Velocity limit" (Ft-
2.12) and Analogue Speed Command. 

0x3 

Default: Disabled 

Applicable 
Operating 
Mode 

All 

When 
Enabled 

Servo-Off  -> Setting 

Description: 

• Limits the operation speed to below this set value in all control modes. . 
• There are two methods of  speed limitation: limitation thorough this value and limitation through speed 
command of  upper level controller. Configure by referring to speed limit method selection of  [Ft-2.13]. 
• In addition, in torque control mode, the mode is changed automatically to speed control mode if  motor 
speed exceeds this value; speed control is performed using limit speed command. 
• If  the analog speed command exceeds motor‟s maximum speed, the excessive speed command warning 
“OSC” is issued. 
• If  excessive speed command warning is issued, the speed command is automatically reduced to the motor‟s 
maximum speed. 

Parameter: [Ft – 2.12] 

Range: 1~6000 

Default: 5000 

Units: RPM for rotary motors, mm/sec for linear motors 
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Applicable 
Operating 
Mode: 

Follower, Analog Velocity, Preset 

When Enabled Servo-Off  -> Setting 

 

Drive -Acceleration Limits-Acceleration Limits 

Description 
Sets the state of  the Acceleration and Deceleration Limits in the drive, for the Analog Velocity and Preset 
Velocity operation modes. 

Parameter: - 

Range: 

Select Description Value 

Inactive Inactive - 

Active Active - 

Default: Active 

Applicable 
Operating 
Mode 

All 

When 
Enabled 

Servo-Off  -> Setting 

Description: Acceleration means slope of  the Speed Profile. 

Parameter: [Ft – 2.02] 

Range: 0.01 ~ 21,474,836.47for rotary,1~2147483647 for linear 

Default: 416.67for rotary, 41667 for linear 

Units: Rev/sec2 for rotary, mm/sec2 for linear 

Applicable 
Operating 
Mode: 

Analog Velocity Input, Preset Velocity 

When 
Enabled 

Immediately 

Description: Deceleration means slope of  the Speed Profile. 

Parameter: [Ft – 2.03] 

Range: 0.01 ~ 21,474,836.47for rotary,1~2147483647 for linear 

Default: 416.67for rotary, 41667 for linear 

Units: Rev/sec2 for rotary, mm/sec2 for linear 

Applicable 
Operating 
Mode: 

Analog Velocity Input, Preset Velocity 

When 
Enabled 

Immediately 
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Description: 

S-operation time set for smooth operation 
• Applied only when acceleration/deceleration time have been set. If  value is set to „0‟, S-operation is not 
performed; if  a value other than „0‟ is set, S-operation is performed on acceleration/ deceleration. 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Parameter: [Ft – 2.04] 

Range: 0~5000 

Default: 0 

Units: ms 

Applicable 
Operating 
Mode: 

All 

When 
Enabled 

Immediately 

 

Drive - Communications - Drive Address 

Description: The drive's communication port address 

Parameter: [Ft – 0.07] 

Range: 1~247 

Default: 1 

Applicable 
Operating 
Mode 

All 

When 
Enabled 

Immediately 

Description Select the motor‟s rotation direction 

Parameter [Ft – 0.02]- Digit 2 

Range: 

Select Description Value 

Normal 
The command signal is not inverted so that a positive 
command value results in CW Rotation, (as viewed from 
shaft end). 

0x0 

Inverted 
The command signal is inverted so that a positive command 
value results in CCW Rotation, (as viewed from shaft end). 

0x1 

Default: Normal 

Applicable 
Operating 
Mode 

All 

When Servo-Off  -> Setting 
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Enabled 

 

Description 
Select a baud rate for the drive.  
Note: This parameter is supported for CSD5 drive. There are two types of  Baudate for KNX3 Drive. RS-485 
Port Baudrate and RS-232C Port Baudrate should be selected respectively. 

Parameter [Ft – 0.09]- Digit 0 

Range: 

Select Description Value 

9600bps 9600bps 0x0 

14400bps 14400bps 0x1 

19200bps 19200bps 0x2 

38400bps 38400bps 0x3 

56000bps 56000bps 0x4 

57600bps 57600bps 0x5 

Default: 57600bps 

Applicable 
Operating 
Mode 

All 

When 
Enabled 

Immediately 

 

Description Select the drive's communications port packet framing format. 

Parameter [Ft – 0.09]- Digit 1 

Range: 

Select Description Value 

8 Data, No Parity, 1 Stop bit 8, No, 1 0x0 

8 Data, Even Parity, 1 Stop bit 8, Even, 1 0x1 

8 Data, Odd Parity, 1 Stop bit 8, Odd, 1 0x2 

8 Data, No Parity, 2 Stop bit 8, No, 2 0x3 

8 Data, Even Parity, 2 Stop bit 8, Even, 2 0x4 

8 Data, Odd Parity, 2 Stop bit 8, Odd, 2 0x5 

Default: 8 Data, No Parity, 1 Stop bit 

Applicable 
Operating 
Mode 

All 

When 
Enabled 

Immediately 

 

Description Select the drive‟s communications protocol 

Parameter [Ft – 0.09]- Digit 2 

Range: 

Select Description Value 

ASCII ASCII 0x0 

MODBUS-RTU MODBUS-RTU 0x1 

Default: ASCII 

Applicable 
Operating 
Mode 

All 

When 
Enabled 

Immediately 
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Description Select the drive‟s communications Method. Note: This parameter is only supported for CSD5 drive. 

Parameter [Ft – 0.09]- Digit 3 

Range: 

Select Description Value 

RS232 RS232 0x0 

RS485 RS485 0x1 

Default: RS232 

Applicable 
Operating 
Mode 

All 

When 
Enabled 

Immediately 

Description 
It is used for selection of  run-xx or Input function using Modbus. Run function cannot be used by key pad, 
similarly, if  the run function is used by Modbus. Note: This parameter is only supported for CSD5 drive. 

Parameter [Ft – 0.32]- Digit 1 

Range: 

Select Description Value 

Disable Not use both Run and Input function by Modbus 0x0 

Enable Use run function only 0x1 

Default: Disable 

Applicable 
Operating 
Mode 

All 

When 
Enabled 

Servo-Off  -> Setting 

Description 
It is used for selection of  Input function using Modbus. Input function on Hardware cannot be used in case 
that the input function is used by Modbus with this parameter. Note: This parameter is only supported for 
CSD5 drive. 

Parameter [Ft – 0.32]- Digit 0 

Range: 

Select Description Value 

Disable Not use both Run and Input function by Modbus 0x0 

Enable Use Input function only 0x1 

Disable + Special 
Function 

use both Run and Input function by Modbus 0x2 

Default: Disable 

Applicable 
Operating 
Mode 

All 

When 
Enabled 

Servo-Off  -> Setting 

 

Drive - Current Limits - Positive Internal 

Description It limits positive torque in [%] unit related to rated torque. (internally limited) 

Parameter [Ft – 4.01] 

Range: 0~500 

Default: 300 
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Units: % of  motor rated continuous current 

Applicable 
Operating 
Mode: 

All 

When 
Enabled 

Immediately 

Description It limits positive torque in [%] unit related to rated torque. (Internally limited) 

Parameter [Ft – 4.02] 

Range: 0~500 

Default: 300 

Units: % of  motor rated continuous current 

Applicable 
Operating 
Mode: 

All 

When 
Enabled 

Immediately 

Description 

• The torque imposed on the motor is internally limited automatically by the values set on [Ft-4.01], [Ft-4.02]. 
Additionally, it is also limited by the values set on [Ft-4.03], [Ft-4.04] when external </P-TL>, </N-TL> 
signals are input through sequence input. 
• The torque limit according to internal limit [Ft-4.01] and [Ft-4.01] takes precedence to external torque limit 
</P-TL> and </N-TL> signals. 
• If  </P-TL> is ON, it limits positive torque in [%] unit related to rated torque. 

 
 

Parameter [Ft – 4.03] 

Range: 0~500 

Default: 100 

Units: % of  motor rated continuous current 

Applicable 
Operating 
Mode: 

All 

When 
Enabled 

Immediately 

Description If  </N-TL> is ON, it limits negative torque in [%] unit related to rated torque. 

Parameter [Ft – 4.04] 

Range: 0~500 

Default: 100 

Units: % of  motor rated continuous current 
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Applicable 
Operating 
Mode: 

All 

When 
Enabled 

Immediately 

 

Description Select the software overtravel monitor enablement. 

Parameter [IN 00.04] 

Range: 

Select Description Value 

Off Turns off  software overtravel limit checking 0x0 

On 

Causes the drive to compare the motor feedback 
position to the Positive and Negative Software Limits, 
below, to determine if  the drive has exceeded an 
overtravel limit. 

0x1 

Default: Off 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Disable drive 

Description If  the motor feedback position is greater than this value, the drive has exceeded the software overtravel limit. 

Parameter [IN 00.05] 

Range: -2,147,483,647~2,147,483,647 

Default: 2,147,483,647 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Disable drive 

Description If  the motor feedback position is less than this value, the drive has exceeded the software overtravel limit 

Parameter [IN 00.06] 

Range: -2,147,483,647~2,147,483,647 

Default: -2,147,483,647 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Disable drive 

Description The stopping distance used when the drive encounters a positive overtravel limit. 

Parameter [IN 00.02] 

Range: 0~2,147,483,647 

Default: 0 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Always 
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Description The stopping distance used when the drive encounters a negative overtravel limit. 

Parameter [IN 00.03] 

Range: 0~2,147,483,647 

Default: 0 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Always 

 

Drive -Speed Functions - Speed Window 

Description 
If  the speed error < Speed Window for 10 ms and the Within Speed Window output signal is assigned, then the 
Within Speed Window output is turned ON 

Parameter [Ft-5.03] 

Range: 0-1000 

Default: 10 

Units: RPM for rotary motors, mm/sec for linear motors 

Applicable 
Operating 
Mode: 

Follower, Analog Velocity Input, Preset Velocity 

When 
Enabled 

Immediately 

Description 
If  the motor speed > Up to Speed and the Up to Speed output signal is assigned, then the Up to Speed output 
is turned ON. 

Parameter [Ft-5.04] 

Range: 1~5000 

Default: 20 

Units: RPM for rotary motors, mm/sec for linear motors 

Applicable 
Operating 
Mode: 

All 

When 
Enabled 

Immediately 

Description 
If  the Analog Speed Command < Zero Clamp, then the analog speed command is ignored and the motor 
command speed is set to zero. 

Parameter [Ft-5.05] 

Range: 0~5000 

Default: 0 

Units: RPM for rotary motors, mm/sec for linear motors 

Applicable 
Operating 
Mode: 

Analog Velocity 

When 
Enabled 

Immediately 
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Description 
If  position error < In Position Size for 1 ms and the In Position Size output signal is assigned, the In Position 
output is turned ON. 

Parameter [Ft-5.00] 

Range: 0~2500 

Default: 10 

Units: Counts 

Applicable 
Operating 
Mode: 

Follower 

When 
Enabled 

Immediately 

Description 
If  position error < Near Position Size and the Near Position output signal is assigned, the Near Position output 
is turned ON 

Parameter [Ft-5.02] 

Range: 0~2500 

Default: 20 

Units: Counts 

Applicable 
Operating 
Mode: 

Follower 

When 
Enabled 

Immediately 

 

Drive - Motor Encoder Units - Position Label 

Description 
When User is selected for Displayed Units, above, this is the user-defined label for position values relating to 
the motor encoder.  

Parameter - 

Range: Limited to 16 characters in length 

Default: Counts 

Units: - 

Applicable 
Operating 
Mode: 

All 

When 
Enabled 

Immediately 

Description 
When User is selected for Displayed Units, above, this is the user-defined conversion factor used to convert 
position values, relating to the motor encoder, into user units. In Counts per User Unit. 

Parameter - 

Range: - 

Default: 1 

Units: In Counts per User Unit 

Applicable 
Operating 
Mode: 

All 

When 
Enabled 

Immediately 

Description 
When User is selected for Displayed Units, above, this is the user-defined label for velocity values relating to 
the motor encoder.  
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Parameter  

Range: Limited to 16 characters in length 

Default: RPM 

Units: - 

Applicable 
Operating 
Mode: 

All 

When 
Enabled 

Immediately 

Description 
When User is selected for Displayed Units, above, this is the user-defined conversion factor used to convert 
velocity values, relating to the motor encoder, into user units. In Counts per second per User Unit. 

Parameter - 

Range: - 

Default: 1 

Units: RPM 

Applicable 
Operating 
Mode: 

All 

When 
Enabled 

Immediately 

Description 
When User is selected for Displayed Units, above, this is the user-defined label for acceleration values relating 
to the motor encoder. Limited to 16 characters in length. 

Parameter - 

Range: - 

Default: Revs/s/s 

Units:  

Applicable 
Operating 
Mode: 

All 

When 
Enabled 

Immediately 

Description 
When User is selected for Displayed Units, above, this is the user-defined conversion factor used to convert 
acceleration values, relating to the motor encoder, into user units. In Counts per second squared per User Unit. 

Parameter - 

Range: - 

Default: 1 

Units: Revs/s^2 per User Units 

Applicable 
Operating 
Mode: 

All 

When 
Enabled 

Immediately 

 

Drive - Stopping Functions - Over Travel Stop Method 

Description Set stopping current with Over travel Current limit parameter 

Parameter [Ft-0.02]-Digit 1 

Range: Select Description Value 
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Current Control 
Stop the motor while continuing the normal torque 
control. 

0x0 

Dynamic Brake Stops at  "Dynamic Brake" in the mode selected 0x1 

Default: Current Control 

Applicable 
Operating 
Mode 

All 

When 
Enabled 

Servo-Off  -> Setting 

Description 

•Limits the torque imposed on the motor if  the motor is halted by overtravel (<P-OT>,<N-OT>) input signal 
during rotation. 
•Unlike external and internal torque limit, the torque limit value for overtravel input is same for forward and 
reverse direction. 

Parameter [Ft-4.05] 

Range: 0~500 

Default: 300 

Units % of  motor rated continuous current 

Applicable 
Operating 
Mode 

All 

When 
Enabled 

Immediately 

Description Set the Dynamic Brake(DB) stop method 

Parameter [Ft-0.02]-Digit 0 

Range: 

Select Description Value 

Brake and hold DB stop is maintained even after the complete stop. 0x0 

Brake and release 
DB Stop. DB operation is released after the complete 
stop. 

0x1 

Free stop The DB is not used, but free run stop. 0x2 

Free stop and hold 
Free run stop. DB operation is maintained after the 
complete stop. 

0x3 

Default: Brake and hold 

Applicable 
Operating 
Mode 

All 

When 
Enabled 

Servo-Off  -> Setting 

Description 
Disable Delay is the time from when Drive Disable command is received to when the Drive Disable command 
is actually executed. 

Parameter [Ft-5.07] 

Range: 0~10000 

Default: 0 

Units: ms 

Applicable 
Operating 
Mode: 

All 

When Servo-Off  -> Setting 
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Enabled 

Description 
The Braking Application Speed is the feedback speed below which the motor break is engaged, after disabling 
the drive. 

Parameter [Ft-5.09] 

Range: 0~10000 

Default: 100 

Units: RPM for rotary motors, mm/sec for linear motors 

Applicable 
Operating 
Mode: 

All 

When 
Enabled 

Servo-Off  -> Setting 

 

Drive - Auxiliary Function Selection 1- Velocity Observer 

Description 
Selection of  velocity monitor use, When high resolution encoder is used by activating velocity monitor, the 
speed ripple occurring at low velocity operation can be reduced. 

Parameter [Ft-0.05]-Digit 1 

Range: 

Select Description Value 

Disable Disable 0x0 

Enable Enable 0x1 

Default: Disable 

Applicable 
Operating 
Mode 

All 

When 
Enabled 

Servo-Off  -> Setting -> After power cycle 

Description Select the emergency stop input enablement 

Parameter [Ft-0.05]-Digit 3 

Range: 

Select Description Value 

Disable Disable 0x0 

Enable Enable 0x1 

Default: Disable 

Applicable 
Operating 
Mode 

All 

When 
Enabled 

Servo-Off  -> Setting -> After power cycle 

 
The following statuses are displayed by default for an CSD5 drive in the On-
Line Drives branch of the Workspace window: 
 

Note: All ON statuses have a value of 1; all OFF statuses have a value of 0. 

Current Operating Mode ON indicates the current of operating mode setting. 
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Within Position Window 
ON indicates position error has been less than the In 
Position Size setting for longer than the In Position 
Time setting. 

Up to Speed 
ON indicates motor velocity feedback is greater than 
the Up To Speed setting. 

Fault/Warning If no error, it indicates "no error". 

Positive Overtravel 

ON indicates positive overtravel limit sensor is 
detected or position feedback exceeds positive 
software overtravel limit in case of using indexing 
mode. 

Negative Overtravel 

ON indicates negative overtravel limit sensor is 
detected or position feedback exceeds negative 
software overtravel limit in case of using indexing 
mode. 

 
The following commands can be executed for an CSD5 Drive window that is 
located in the On-Line Drives branch. These commands are explained in the 
following sections: 
 

Velocity Control Panel 

Opens the Velocity Control Panel window. Refer to 
Velocity Control Panel Window on page 44 for more 
information about how to set a drive's velocity 
command and monitor its motor velocity or current. 

Reset Drive 
Resets, or reboots, the hardware and firmware for a 
drive. 

Reset to Factory settings 
Resets a drive's parameters by reinitializing them to 
factory default settings. Stored faults and the Time in 
Service clock remain unchanged 

Save parameters Save parameters 

 
Customize the window for your CSD5 Drive branch by selecting one or more 
of the following buttons: 

• Toggle the Show Status selection to display or hide the Status pane. 

• Toggle the Show Commands selection to display or hide the 
Commands pane. 

• Click on the Setup button to open the Monitor Setup window as shown 
on page 112, where you can customize the status display for this window. 

• Click on the Revert button to return parameter settings to the values 
they held when you opened this window. 

The Properties window for the Velocity Control Panel looks like this: 
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Note: The command buttons (Jog Forward/Reverse/Enable/Disable) can be 
displayed for CSD5 Drive window that is located in the On-Line Drive branch. 
 
Use the Velocity Control Panel window to directly set the drive's velocity 
command. In support of these functions, you can also: 

• Jog Forward/Jog Reverse 

• Jog /Enable or Jog/Disable 

The commands you execute override any motion commands originating from 
the drive's normal operation mode, set in the CSD5 Drive window. 
 

 

 
 

The Velocity Control Panel commands override the normal 
operation mode. The motor moves in response to Velocity 
Control Panel commands! 

 
The Velocity Control Panel has the following parameters, statuses and direct 
commands: 
 

Description 

Sets speed for jog operation using (run-00). 
The speed, at which the motor turns when the Velocity Mode command executes, provided that the drive is 
on-line and enabled. 
Note: The drive ramps up, or ramps down, to the commanded velocity at the rate of  acceleration set in the 
Acceleration input box. 

Parameter [Ft-2.01] 

Range: 0~6000 

Default: 50 

Units: RPM for rotary motors, mm/sec for linear motors 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

 
The following commands can be executed from the Velocity Control Panel 
window of an on-line drive: 
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Jog Forward Move forward direction 

Jog Reverse Move reverse direction 

Jog Enable Enables the power stage of a drive 

Jog Disable Disables the power stage of a drive. 

Customize the Velocity Control Panel window for your CSD5 Drive by 
selecting one or more of the following buttons: 

• Toggle the Show Commands selection to display or hide the 
Commands pane. 

• Click on the Revert button to return parameter settings to the values 
they held when you opened this window. 

The Properties window for the Analog branch looks like this: 

Note: The Properties window for Analog of CSD5 Drive and KNX3 Drive are 
not same. The below is an illustration of CSD5 Drive. 

 

 
Use the Analog window to: 

• set Analog Velocity, Current and Command Input drive parameters for 
an on-line or off-line drive, 

• monitor the status of the incoming Analog Command for an on-line 
drive, and  

• execute commands that remove Velocity, Current and Input Offsets for 
an on-line drive. 

These parameters govern drive operations when the Operating Mode is set to 
Analog Velocity Input, or Analog Current Input, in the window. 
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Drive - Mode Configuration - Analog- Velocity Scale 

Description 
• Sets the speed command value[rpm] for the analog speed command input pin(Pin 19,20 of  I/O) 
• Speed command[rpm] = Ft-2.00 [rpm/V] x Input voltage[V] 

Parameter [Ft-2.00] 

Range: 10.0~2000.0 

Default: 500.0 

Units: RPM/V for rotary motors, mm/sec for linear motors   

Applicable 
Operating 
Mode: 

Analog Velocity 

When 
Enabled 

Servo-Off  -> Setting 

Description 
• Set the speed command value[%] for 1[V] on the analog torque command input pin(pin 21,22 of  I/O) 
• Torque command[%] = [Ft-4.00] [%/V] x input voltage[V] 

Parameter [Ft-4.00] 

Range: 0-100 

Default: 33.3 

Units: % of  motor rated continuous current/Volt 

Applicable 
Operating 
Mode: 

Analog Current Command, Dual Current Command 

When 
Enabled 

Servo-Off  -> Setting 

Description The drive's velocity input offset value. This value indicates the offset of  the Analog Command Input. 

Parameter - 

Range: -10,000~10,000 

Default: 0.0 

Units: mV 

Applicable 
Operating 
Mode: 

Analog Velocity Command 

When 
Enabled 

Servo-Off  -> Setting 

Description The drive's current input offset value. This value indicates the offset of  the Analog Command Input. 

Parameter - 

Range: -10,000~10,000 

Default: 0.0 

Units: mV 

Applicable 
Operating 
Mode: 

Analog Velocity Command 

When 
Enabled 

Servo-Off  -> Setting 

 
You can edit Analog parameters for both an on-line and an off-line drive. 
However, you can monitor statuses and execute direct commands (i.e., 
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executed through the RSWare interface) only for a Analog window that is the 
child of an on-line drive.  
 
The following status is displayed by default for an Analog window of an on-line 
drive: 
 

Analog Command - Velocity External Analog Velocity Command 

Analog Command - Current External Analog Current Command 

Command Velocity Actual Velocity Command  

Command Current Actual Current Command 

 

The following commands can be executed for an Analog window that is located 
in the On-Line Drives branch: 
 

Remove Velocity Input 
Offset 

This command automatically measures the existing 
offset of the Analog Command Input, and resets the 
Velocity Offset value to eliminate the offset. 

Remove Current Input 
Offset 

This command automatically measures the existing 
offset of the Analog Command Input, and resets the 
Current Offset value to eliminate the offset. 

Save parameters Save parameters 

 
Customize the Analog window for your CSD5 Drive branch by selecting one or 
more of the following buttons: 

• Toggle the Show Status selection to display or hide the Status pane. 

• Toggle the Show Commands selection to display or hide the 
Commands pane. 

• Click on the Setup button to open the Monitor Setup window as shown 
on page 112, where you can customize the status display for this window. 

• Click on the Revert button to return parameter settings to the values 
they held when you opened this window. 

The Properties window for Presets looks like this: 
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Use the Preset window to configure: 

• up to seven preset velocity values 

Preset parameters control drive operation when the Operating Mode is set to 
Preset Velocity in the CSD5 Drive window. 
 
The drive uses the preset velocity value selected by the Preset Select Lines 0, 1 
and 2 as set in the Digital Inputs properties window. 
 
The digital input's Preset Select Line binary values are as follows: 

• Preset Select 0 = 1 if active, 0 if not. 

• Preset Select 1 = 2 if active, 0 if not. 

• Preset Select 2 = 4 if active, 0 if not. 

 
If a Preset Select Line is not assigned to a digital input, the Preset Select Line is 
considered inactive. 
 
If you only want to use a single gear ratio, simply set up the Gear Ratio for 
Preset 0, and don't assign the Preset Select 0, 1 or 2 to any digital inputs. 
 
Note: Binary values for an active digital input's Preset Select Lines 3, 4 and 5 do 
not apply to this calculation. 
 
The Preset window has no associated statuses or direct commands. The Preset 
window has the following parameters: 
 

Description 

• Sets each contact speed commands for contact speed control mode 
• The operation speed should be entered in advance into the relevant parameters </C-SP1>, </C-SP2>, </C-
SP3>. 
• According to combination of  the sequence input signals </C-SP1>, </C-SP2>, </C-SP3>, operation at 
preset speed is possible. 
• In addition, sequence input signal </C-DIR> is used to change the rotation direction of  each speed 
command. 
• To reduce impact of  speed change, set the acceleration/deceleration time to a sufficient value which should 
not interfere with system responsiveness 

Parameter [Ft-2.05] 

Range: -6000~6000 
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Default: 0 

Units: RPM for rotary motors, mm/sec for linear motors 

Applicable 
Operating 
Mode: 

Preset 

When 
Enabled 

Immediately 

Table.  Rotational speed depending on signals </C-SP1>, </C-SP2>, </C-SP3>. 

Preset Velocity Parameters  </C-SP3> </C-SP2> </C-SP1> 

Stop Command 0(rpm) 0 0 0 

Preset Velocity 1 Ft- 2.05 0 0 1 

Preset Velocity 2 Ft- 2.06 0 1 0 

Preset Velocity 3 Ft- 2.07 0 1 1 

Preset Velocity 4 Ft- 2.08 1 0 0 

Preset Velocity 5 Ft- 2.09 1 0 1 

Preset Velocity 6 Ft- 2.10 1 1 0 

Preset Velocity 7 Ft- 2.11 1 1 1 
 

Description Refer to description of  [Ft-2.05]  

Parameter [Ft-2.06] 

Range: -6000~6000 

Default: 0 

Units: RPM for rotary motors, mm/sec for linear motors 

Applicable 
Operating 
Mode: 

Preset 

When 
Enabled 

Immediately 

Description Refer to description of  [Ft-2.05]  

Parameter [Ft-2.07] 

Range: -6000~6000 

Default: 0 

Units: RPM for rotary motors, mm/sec for linear motors 

Applicable 
Operating 
Mode: 

Preset 

When 
Enabled 

Immediately 

Description Refer to description of  [Ft-2.05]  

Parameter [Ft-2.08] 

Range: -6000~6000 

Default: 0 

Units: RPM for rotary motors, mm/sec for linear motors 

Applicable 
Operating 
Mode: 

Preset 

When Immediately 
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Enabled 

Description Refer to description of  [Ft-2.05]  

Parameter [Ft-2.09] 

Range: -6000~6000 

Default: 0 

Units: RPM for rotary motors, mm/sec for linear motors 

Applicable 
Operating 
Mode: 

Preset 

When 
Enabled 

Immediately 

Description Refer to description of  [Ft-2.05]  

Parameter [Ft-2.10] 

Range: -6000~6000 

Default: 0 

Units: RPM for rotary motors, mm/sec for linear motors 

Applicable 
Operating 
Mode: 

Preset 

When 
Enabled 

Immediately 

Description Refer to description of  [Ft-2.05]  

Parameter [Ft-2.11] 

Range: -6000~6000 

Default: 0 

Units: RPM for rotary motors, mm/sec for linear motors 

Applicable 
Operating 
Mode: 

Preset 

When 
Enabled 

Immediately 

 
Click on the Revert button to return parameter settings to the values they held 
when you opened this window. 

The Properties window for Followers looks like this: 
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Follower parameters control drive operation when the Operating Mode is set to 
one of the following: 

• Step Up/Step Down. Positive Logic 

• Step Up/Step Down. Negative Logic 

• Step/Direction. Positive Logic 

• Step/Direction. Negative Logic 

• Auxiliary Encoder. X1 

• Auxiliary Encoder. X2 

• Auxiliary Encoder. X4 

in the CSD5 Drive window. 
 
The Follower window has no associated statuses or direct commands. The 
Follower window has the following parameters: 
 

Description 

Note: For Command types 0x4, 0x5, and 0x6: 
Motor Counts = Master Lines * MULT *  …… 
…..  (4 * Para3.01) / Para3.02 
where MULT is 1, 2 or 4 for command types 0x4, 0x5 and 0x6 respectively. 

Parameter [Ft-3.00]-Digit0 

Range: 

Select Description Value 

Step Up/Step Down, Positive logic Step Up/Step Down, Positive logic 0x0 

Step Up/Step Down, Negative logic Step Up/Step Down, Negative logic 0x1 

Step/Direction, Positive Logic Step/Direction, Positive Logic 0x2 

Step/Direction, Negative Logic Step/Direction, Negative Logic 0x3 

Auxiliary Encoder, x1 A phase + B phase, x1 0x4 

Auxiliary Encoder, x2 A phase + B phase, x2 0x5 

Auxiliary Encoder, x4 A phase + B phase, x4 0x6 

Default: Step Up/Step Down, Positive logic 

Applicable 
Operating 
Mode 

Follower 

When 
Enabled 

Servo-Off  -> Setting  

Drive - Mode Configuration - Follower - Controller Output Type 
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Description Select the host controller output type 

Parameter [Ft-3.00]-Digit1 

Range: 

Select Description Value 

Line Drive Input 
Use Low speed Line Drive Output in Host Controller 
for isolated electrical connection. (900kHz Max) 

0x0 

Open Collector Input 
Use Open Collector in Host Controller. (250kHz 
Max) 

0x1 

High Frequency Line 
Drive Input 

Use High Frequency Line Drive Output in Host 
Controller.(3MHz Max) 

0x2 

Default: Line Drive Input 

Applicable 
Operating 
Mode 

Follower 

When 
Enabled 

Servo-Off  -> Setting  

Description: Select the drive state to make 1st gear ratio take effect 

Parameter [Ft-3.00]-Digit3 

Range: 

Select Description Value 

Enable Only on Drive Disabled Enable Only on Drive Disabled 0x0 

Always Enable Always Enable 0x1 

Default: Enable Only on Drive Disabled 

Applicable 
Operating 
Mode: 

Follower 

When 
Enabled 

Servo-Off  -> Setting 

Description: 

• Denominator of  Electronic gear([Ft-3.01]) 
• Numerator of  Electronic gear([Ft-3.02]) 
• By using the electronic gear function, the amount of  motor rotation pr input command pulse can be set 
arbitrarily. 
• The following relationship has to be satisfied: No. of  pulses per 1 motor rotation x Reduction ratio x 4 (Pr-
3.02) 
• Maximum resolution=1/ ([No.of  pulses per 1 motor rotation] x [Reduction ratio] x 4) 

Parameter [Ft-3.01]( Denominator of  Electronic gear), [Ft-3.02]( Numerator of  Electronic gear) 

Range: 1~65535 

Default: 360:10000 

Units: Master Counts : Follower Counts 

Applicable 
Operating 
Mode: 

Follower 

When 
Enabled 

Servo-Off  -> Setting 

Description: 

• Denominator of  2nd Gear Ratio ([Ft-3.04]) 
• Numerator of  2nd Gear Ratio ([Ft-3.05]) 
• By using the electronic gear function, the amount of  motor rotation pr input command pulse can be set 
arbitrarily. 
• The following relationship has to be satisfied: No. of  pulses per 1 motor rotation x Reduction ratio x 4 (Ftr-
3.02) 
• Maximum resolution=1/ ([No.of  pulses per 1 motor rotation] x [Reduction ratio] x 4) 

Parameter [Ft-3.04]( Denominator of  2nd Gear Ratio), [Ft-3.05]( Numerator of  2nd Gear Ratio) 

Range: 1~65535 

Default: 1:4 
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Units: Master Counts : Follower Counts 

Applicable 
Operating 
Mode: 

Follower 

When 
Enabled 

Servo-Off  -> Setting 

 

Description The controller has differential TTL/CMOS outputs 

Parameter [Ft-3.08]-Digit0 

Range: 

Select Description Value 

3.000 3.000 MHz 0x0 

1.750 1.750 MHz 0x1 

1.500 1.500 MHz 0x2 

1.000 1.000 MHz 0x3 

0.750 0.750 MHz 0x4 

0.625 0.625 MHz 0x5 

0.562 0.562 MHz 0x6 

0.525 0.525 MHz 0x7 

Default: 1.000 

Applicable 
Operating 
Mode 

All 

When 
Enabled 

Servo-Off  -> Setting  

Description The controller has single-ended transistor outputs 

Parameter [Ft-3.08]-Digit1 

Range: 

Select Description Value 

3.000 3.000 MHz 0x0 

1.750 1.750 MHz 0x1 

1.500 1.500 MHz 0x2 

1.000 1.000 MHz 0x3 

0.750 0.750 MHz 0x4 

0.625 0.625 MHz 0x5 

0.562 0.562 MHz 0x6 

0.525 0.525 MHz 0x7 

Default: 0.525 

Applicable 
Operating 
Mode 

All 

When 
Enabled 

Servo-Off  -> Setting  

Description The controller has differential TTL/CMOS outputs 

Parameter [Ft-3.08]-Digit2 

Range: 

Select Description Value 

3.000 3.000 MHz 0x0 

1.750 1.750 MHz 0x1 

1.500 1.500 MHz 0x2 
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1.000 1.000 MHz 0x3 

0.750 0.750 MHz 0x4 

0.625 0.625 MHz 0x5 

0.562 0.562 MHz 0x6 

0.525 0.525 MHz 0x7 

Default: 3.000 

Applicable 
Operating 
Mode 

All 

When 
Enabled 

Servo-Off  -> Setting  

 
Click on the Revert button to return parameter settings to the values they held 
when you opened this window. 

The Properties window for Indexing looks like this: 

Note: The Properties window for Indexing of CSD5 Drive and KNX3 Drive 
are not same. The below is an illustration of CSD5 Drive. 

 
 
Use the Indexing window to: 
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• configure up to sixty-four indexes (0 ~63)for CSD5 Drive.[ (0~6) for 
KNX3 Drive], and 

• open the Indexing Control Panel where you can: 

-start and stop execution of the index command 

-start and stop homing 

-enable or disable a drive, and 

-monitor the execution of an index. 

An index controls drive operation by executing preconfigured motion 
commands. 
 
An index controls drive operation when Operating Mode is set to Indexing, in 
the CSD5 Drive window. The drive uses the index whose number (0 ~63) 
reflects the cumulative binary values of the Preset Select Lines 0, 1, 2, 3, 4 and 5, 
that are selected in the Digital Inputs window. 
 
The digital input Preset Select Line binary values are as follows: 

• Preset Select 0 = 1 if active, 0 if not. 

• Preset Select 1 = 2 if active, 0 if not. 

• Preset Select 2 = 4 if active, 0 if not. 

• Preset Select 3 = 8 if active, 0 if not. 

• Preset Select 4 = 16 if active, 0 if not. 

• Preset Select 5 = 32 if active, 0 if not 

If a Preset Select Line is not assigned to a digital input, the Preset Select Line is 
considered inactive. 
 
The following parameters, statuses and commands apply to Indexing: 
 

Description When this field is set to "on", the drive will begin executing the selected index whenever the drive enables. 

Parameter [IN00.00] 

Range: 

Select Description Value 

Off 
Drive starts to move to the selected 
index with start indexing input after 
drive enable 

0x0 

On 
Drive starts to move to the selected 
index without start indexing input after 
drive enable 

0x1 

Default: Off 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Power Cycling 
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Description The deceleration used to stop motion when the Stop Index input terminates an index move. 

Parameter [IN00.01] 

Range: 0.01~21474836.47 for rotary; 0.001~2147483.647 for linear. 

Default: 62.50 for rotary,6.250for linear 

Units: *Rev/sec2 for rotary, mm/sec2 for linear 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Always 

 

Description 
This parameter is the user defined distance per motor 1 revolution in order to change the unit of  indexing point 
distance 

Parameter [IN00.07] 

Range: 0~99,999 

Default: 0 

Units: User Defined 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Power Cycling 

 

 

Description 
Note: The axis must be homed before the drive can execute any index. The shaded “Registration” is not 
available at Phase 2 

Parameter [IN02.00~IN02.63]-Digit 0 

Range: 

Select Description Value 

Absolute 
Moves from its starting position to the specified 
Position, below. 

0x0 

Incremental 
Moves from its starting position the specified Distance, 
below. 

0x1 

Default: Incremental 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Always 

 

Description 
Position: For Absolute mode moves, the fixed position to which the motor will travel.  
Distance: For Incremental and Registration mode moves, the relative distance the motor will travel. 

Parameter [IN04.00~IN04.63] 

Range: -2,147,483,647~2,147,483,647 

Default: 0 

Units: Counts 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Always 
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Description Milliseconds to remain at current position before executing 

Parameter [IN07.00~IN07.63] 

Range: 0~65,535 

Default: 0 

Units: ms 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Always 

 

Description Maximum velocity while in motion. 

Parameter [IN08.00~IN08.63] 

Range: 0~6000 for rotary;0.000~6.000for liner 

Default: 750 for rotary;0.750 for linear 

Units: RPM for rotary motors, mm/sec for linear motors 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Always 

 

Description Maximum velocity while in motion. 

Parameter [IN10.00~IN10.63] 

Range: 0.01~21474836.47 for rotary; 0.001~2147483.647 for linear. 

Default: 62.50 for rotary,6.250for linear 

Units: *Rev/sec2 for rotary, mm/sec2 for linear 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Always 

 

Description Maximum deceleration while in motion 

Parameter [IN11.00~IN11.63] 

Range: 0.01~21474836.47 for rotary; 0.001~2147483.647 for linear. 

Default: 62.50 for rotary,6.250for linear 

Units: *Rev/sec2 for rotary, mm/sec2 for linear 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Always 

 

Description The number (0~63) of  the next indexed move to execute when Action When Complete is not set to “Stop”. 

Parameter [IN12.00~IN12.63] 

Range: 0~63 

Default: 0 

Units: - 

Applicable 
Operating 

Indexing 
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Mode 

When 
Enabled 

Always 

 

Description The drive's action when the index has completed. 

Parameter [IN02.00~IN02.63]-Digit 1 

Range: 

Select Description Value 

Stop 
Ends the execution of  indexed move commands 
(default setting). 

0x0 

Start next index 
Commands execution of  the Next Index move without 
additional input, but after the scheduled Dwell. 

0x1 

Wait for Start 
Commands execution of  the Next Index move the next 
time the Start Index input becomes active. 

0x2 

Default: Stop 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Always 

 

The following statuses can be displayed from a Indexing window of an on-line 
drive: 
 

In Motion 

ON indicates the motor is moving in response to an indexed motion 
command. 
Note: The In Motion status has a value of 1 when ON, and 0 when 
OFF. 

In Dwell 

ON indicates the motor is holding position and waiting the 
commanded dwell time. 
Note: The In Dwell status has a value of 1 when ON, and 0 when 
OFF. 

Axis Homed 
ON indicates that the homing routine has completed. 
Note: The Axis Homed status has a value of 1 when ON, and 0 
when OFF. 

 
The following command can be executed from a Indexing window of an on-
line drive: 
 
Customize the Indexing window for your CSD5 Drive by selecting one or more 
of the following buttons: 

• Toggle the Show Status selection to display or hide the Status pane. 

• Toggle the Show Commands selection to display or hide the 
Commands pane 

• Click on the Setup button to open the Monitor Setup window as shown 
on page 112, where you can customize the status display for this window. 

• Click on the Revert button to return parameter settings to the values 
they held when you opened this window. 
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The Properties window for the Indexing Control Panel looks like this: 
 

 
 
The Indexing Control Panel allows the user to select one of sixty-four possible 
indexes, and send direct commands to the selected drive. 
 
Use the Indexing Control Panel window to: 

• Start or stop the execution of an indexed motion command. 

• Start or stop homing. 

• Enable or disable a drive. 

• Reset all drive faults. 

The commands you execute override any motion commands originating from 
the drive's normal operation mode, set in the CSD5 Drive window. 
 

 

 
 

The Indexing Control Panel commands override the normal 
operation mode. The motor moves in response to Indexing 
Control Panel commands! 

 
The Indexing Control Panel has the following parameter, and direct commands: 
 

Index Number 
The number (0 - 63) of the indexed motion 
command, configured in the Indexing window, which 
starts when you select the Start Index. 

 
The following commands can be executed from the Indexing window of an on-
line drive: 
 

Start Index  
Begins execution of  the indexed motion command (0 
- 63) specified in the Index Number parameter. 
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Stop Index 
Stops execution of  the indexed motion command (0 - 
63) specified in the Index Number parameter. 

Start Homing  
Begins execution of  the homing sequence as defined 
in the Homing window. 

Stop Homing  Stops execution of  the homing sequence. 

Enable Drive Enables the power stage of  a drive. 

Disable Drive  Disables the power stage of  a drive. 

Clear Faults  Clears all drive faults 

 
Note: Closing the window returns the drive to its normal operating mode, but 
software disabled. Select the drive and execute an Enable command and 
instructed in the Windows' message to make the drive operational. 
 
Customize the Indexing Control Panel window for your CSD5 Drive by 
selecting one or more of the following buttons: 

• Toggle the Show Status selection to display or hide the Status pane. 

• Toggle the Show Commands selection to display or hide the 
Commands pane 

• Click on the Setup button to open the Monitor Setup window as shown 
on page 112, where you can customize the status display for this window. 

• Click on the Revert button to return parameter settings to the values 
they held when you opened this window. 

The Properties window for the Indexing Teaching Panel looks like this: 
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• Indexing Teaching Panel is added from RSWare Version 1.2.0. 

•  After the motor moved by the Jog operation, “Teaching save" button is 
pressed, the current value of the Follower position is stored as the 
Distance or Position parameters of selected index. 

The Properties window for Homing looks like this: 
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Use the Homing window to configure the type of homing operation the drive 
performs. 
 
Note: Homing operations are performed by issuing the Start Homing 
command from the Indexing Control Panel. 
 
Homing has no associated statuses. Except for Copy and Paste, it just has a 
Save Parameters command. 
 
Note: A homing operation is performed by issuing the Start Homing command 
in the Indexing Control Panel. 
 
The following parameters apply to Homing: 
 

Description Select the type of  homing operation the drive will perform 

Parameter [IN01.00] 

Range: 

Select Description Value 

Home to Present 
Position 

The position when a Start Homing signal is inputted 
becomes the new home. If  the Auto Start Homing 
function is enabled, the position when the drive is 
enabled becomes the new home 

0x0 

To Home 
sensor/Back to 
Marker 

After the active-going 
edge of  the sensor is detected, the drive immediately 
reverses motor direction and looks for the inactive-
going edge of  the sensor. After the inactive-going edge 
of  the sensor is detected, the drive looks for the marker. 
After the marker is detected, the drive moves the motor 
the Offset Move Distance from the marker, reversing if  
necessary. The final position becomes the new Home 
position. The Homing Velocity is used for the initial 
sensor search. After the motor decelerates to a stop 
when it finds the active-going sensor edge, the Creep 
Velocity is used for all the remaining motion. 

0x1 

To Limit/Back to 
Marker 

This homing procedure is the same as the 'To Home 
sensor / Back to Marker', only except that the physical 
overtravel is used instead of  home sensor input. The 
physical overtravel fault is disabled while homing 

0x2 
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To Home 
sensor/Fwd to 
Marker 

After the active-going edge of  the sensor is detected, 
the drive looks for the marker. After the marker is 
detected, the drive moves the motor the Offset Move 
Distance from the marker, reversing if  necessary. The 
final position becomes the new Home position. 

0x3 

To Limit/Fwd to 
Marker 

The homing procedure is the same as the 'To Home 
sensor / Fwd to Marker ', only except that the physical 
overtravel is used instead of  home sensor input. The 
physical overtravel fault is disabled while homing 

0x4 

Home to Current 
Value 

The drive moves the motor at the Homing Velocity 
until the feedback current reaches the Home Current 
Value. After the Home Current Value is hit, the drive 
immediately stops the motor motion and moves the 
Offset Move Distance, reversing if  necessary. The final 
position becomes the new Home position 

0x5 

Home to Current 
Value/Back to Marker 

After the Home Current Value is reached, the drive 
immediately reverses motor direction and looks for the 
marker. After the marker is detected, the drive moves 
the motor the Offset Move Distance from the marker, 
reversing if  necessary. The final position becomes the 
new Home position. The Homing Velocity is used for 
the initial motion until the current value is reached. The 
Creep Velocity is used for all the remaining motion. 

0x6 

To Home 
sensor/Move/Fwd to 
Marker 

Sometimes, the distance is very short between home 
sensor and marker, so it may miss to detect the first 
marker. To prevent this, this method has one more 
parameter to define a minimum distance to detect 
Marker. The minimum distance is defined as a time in 
the „moving distance after home sensor‟. After it detects 
the home sensor input, the velocity is decelerated to the 
creep velocity and it is maintained until the marker is 
detected. After the marker is detected, the motor move 
back to the position 

0x7 

Home to Marker 

After the marker is detected, the drive moves the motor 
the Offset Move Distance from the marker, reversing if  
necessary. The final position becomes the new Home 
position. 

0x8 

Default: To Home Sensor/Back to Marker 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Disable drive 

Description Causes the drive to begin the homing procedure automatically when the drive is enabled. 

Parameter [IN01.01] 

Range: 

Select Description Value 

Active: 
Automatically starts homing every time the drive is 
enabled. 

0x0 

Active After Reset Only 
Automatically starts homing when a drive is 
enabled, if  the drive has not already been homed 

0x1 

Inactive Starts homing with start homing input 0x2 

Default: Inactive 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Power Cycling 
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Description 
The commanded velocity used during homing. The sign of  this value (+/-) indicates the direction of  motion 
during homing. 

Parameter [IN01.02] 

Range: -6,000~6,000 

Default: 100 

Units RPM for rotary motors, mm/sec for linear motors 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Disable drive 

Description The rate of  acceleration and deceleration used during homing 

Parameter [IN01.04] 

Range: 62.50 

Default: 100 

Units Rev/sec2 for rotary, mm/sec2 for linear 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Disable drive 

Description 
The distance the motor position will be from the marker edge (or sensor edge for Sensor only Homing Type) 
after the homing sequence is complete. 

Parameter [IN01.05] 

Range: -2,147,483,647~2,147,483,647 

Default: 0 

Units Counts 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Disable drive 

Description The rate of  drive deceleration used when homing is stopped. 

Parameter [IN01.12] 

Range: 1~2,147,483,647 

Default: 6250 

Units Rev/sec2 for rotary, mm/sec2 for linear 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Disable drive 

Description Specifies the digital input state which indicates to the drive that the Home Sensor input is active 

Parameter [IN01.06] 

Range: Select Description Value 
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Active- Going Transition Active- Going Transition 0x0 

Inactive- Going Transition Inactive- Going Transition 0x1 

Default: Inactive 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Power Cycling 

Description The home position when a homing procedure is completed. 

Parameter [IN01.07] 

Range: -2,147,483,647~2,147,483,647 

Default: 0 

Units Counts 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Disable drive 

Description 
For the To Sensor, then Back to Marker Homing Type, the velocity used for all remaining homing motion after 
the motor decelerates to a stop when it finds the sensor edge. 

Parameter [IN01.03] 

Range: 0~6,000 

Default: 20 

Units RPM for rotary motors, mm/sec for linear motors 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Disable drive 

Description 
Specifies the torque feedback at which the drive stops moving the motor at the Homing Velocity. 
Unit : Percentages of  a motor rating torque 

Parameter [IN01.09] 

Range: 1~250 

Default: 100 

Units % 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Disable drive 

Description This value is distance that the drive ignores the marker inputs after the home sensor is detected. 

Parameter [IN01.08] 

Range: 0~2,147,483,647 

Default: 0 

Units Counts 

Applicable 
Operating 
Mode 

Indexing 
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When 
Enabled 

Disable drive 

Description The time to when the torque feedback is more than the home current to when the drive detects stopper. 

Parameter [IN01.10] 

Range: 0~1,000 

Default: 0 

Units ms 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Disable drive 

Description Drive fault occurs when time for homing is over the homing time limit. 

Parameter [IN01.11] 

Range: 0~65,535 

Default: 60 

Units sec 

Applicable 
Operating 
Mode 

Indexing 

When 
Enabled 

Disable drive 

 
The following statuses can be displayed from a Homing window of an on-line 
drive: 
 

In Motion 

ON indicates the motor is moving in response to an indexed motion 
command. 
Note: The In Motion status has a value of 1 when ON, and 0 when 
OFF. 

In Dwell 

ON indicates the motor is holding position and waiting the 
commanded dwell time. 
Note: The In Dwell status has a value of 1 when ON, and 0 when 
OFF. 

Axis Homed 
ON indicates that the homing routine has completed. 
Note: The Axis Homed status has a value of 1 when ON, and 0 
when OFF. 

 
Customize the Homing window for your CSD5 Drive by selecting one or more 
of the following buttons: 

• Toggle the Show Status selection to display or hide the Status pane. 

• Click on the Revert button to return parameter settings to the values 
they held when you opened this window. 
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The Properties window for Motors looks like this: 

Note: The Properties window for Motors of CSD5 Drive and KNX3 Drive are 
not same. The below is an illustration of CSD5 Drive. 

 

 
 
Use the Motor window to: 

• Select a motor for the associated on-line or off-line CSD5 drive. Once 
you select a motor, the status values associated with the selected motor 
appears in the Status pane of this window. 

• Monitor the statuses that relate to the selected motor. 

The following parameters, statuses and commands apply to motors: 
 

Description Select the type of  homing operation the drive will perform 

Parameter [Ft-0.06]- Digit 0 
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Range: 

Select Description Value 

Disabled 
Causes the drive to read motor parameters 
from a Motor Model selected, below. 

0x0 

   

Enabled 
Causes the drive to read motor parameters 
from an intelligent encoder 

0x1 

Default: Disabled 

Applicable 
Operating 
Mode 

All 

When Enabled Immediately 

Description 

(Only if  Auto Motor Iden is disabled.) The model name of  the selected motor. Only listed motor models are 
valid. 
Note: RSWare ships with a Motor Configuration utility that lets you create custom motor configurations. Use 
that utility to add customized motor selections to the Motor Model list, by clicking on the Start button, then 
selecting Programs, OEMax Software, RSWare and Motor Configuration from the pop-up menus. 

Parameter [Ft-0.01] 

Setting Value: 

•Set three items of  the motor: motor type, motor rated output, and encoder type. 
•check the model name on the motor nameplate. 
•Press Up/Down arrow keys, alphabetic and numeric characters representing each mode is displayed. 
•The following figure is an example of  the nameplate on the motor. Refer to the following figure to set the 
predefined place for each items. 
 

 
Default:  

Applicable 
Operating 
Mode 

All 

When Enabled Servo-Off  -> Setting -> After power cycle 

Description Load Inertia / Motor Inertia 

Parameter [Ft-0.04] 

Range: 0~6000 

Default: 1.00 

Units: (Load inertia/Motor inertia)  

Applicable 
Operating 
Mode 

All 

When Enabled Immediately 

 
The following statuses are displayed by default for the Motor branch of an on-
line drive. 
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Motor Flag 

Either: 
Automatic: 
indicates the drive automatically determines the motor settings by 
communicating with the encoder. 
Standard: 
indicates a motor whose status settings come preconfigured by RSWare. 
Custom: 
indicates a user-configured motor which was added to the Motor Model list, 
above, using the utility that ships with RSWare. 

Motor Type 
Indicate the type of motor: 
Linear 
Rotary 

Torque Constant 
(Only for rotary motors) The sinusoidal force constant, in Newton 
meters/Ampere (N-m/A). 

Inertia Rotor inertia, in Kilogram-centimeter squared (kg-cm2). 

Poles/Revolution The number of motor poles per revolution. 

Integral Limits 
Indicates whether the motor provides built in feedback for travel limits: 
Yes 
No 

Rated Voltage Voltage rating of the motor in Volts. 

Resistance The phase-to-phase resistance of the motor stator, in Ohms. 

Inductance The phase-to-phase inductance of the motor stator, in milliHenries (mH). 

Ratings   

Maximum Speed 
Maximum motor output shaft speed, in revolutions/minute (RPM) for rotary 
motors, meters/second (Meters/sec) for linear motors. 

Intermittent Current Maximum intermittent current of the motor in peak Amperes 

Continuous Current Continuous current rating of the motor in peak Amperes. 

  

Encoder 
The encoder type: 
Incremental 
Sine/Cosine 

Commutation 

The type of commutation: 
Brush 
Trapezoidal 
Sinusoidal 

Hall Input Offset 
Offset Hall Input offset, from standard RS Automation 
orientation, in electrical degrees. 

 
The following commands can be executed for a Motor window of an on-line 
CSD5 drive: 
 

Refresh Data  

Reads the motor definition information from the motor 
database and reapplies it to the drive. 
Note: This command is useful when a motor definition 
in the motor database has been changed. 

Save parameters Save parameters 

 
Customize the Motor window for your CSD5 Drive branch by selecting one or 
more of the following buttons: 

• Toggle the Show Status selection to display or hide the Status pane. 
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• Toggle the Show Commands selection to display or hide the 
Commands pane. 

• Click on the Setup button to open the Monitor Setup window as shown 
on page 112, where you can customize the status display for this window. 

• Click on the Revert button to return parameter settings to the values 
they held when you opened this window. 

The Properties window for the Tuning branch looks like this: 

Note: The Properties window for Tuning of CSD5 Drive and KNX3 Drive are 
not same. The below is an illustration of CSD5 Drive. 
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Use the Tuning window to: 

• Configure Velocity Regulator Response Level and System Gain that are 
used in tuning. 

• Monitor Velocity, Position and Current loop statuses. 

• Open windows where you can execute commands for start autotuning, 
copy main gains to 2nd, 3rd, 4th, all gains. 

RSWare uses a nested digital servo control loop, consisting of an outer position 
regulator (using proportional, integral, derivative and feedforward gains), 
around an inner velocity regulator (using its own set of proportional, integral 
and derivative gains). 
 
Together, these regulators provide software control over the servo dynamics, 
and stabilize the servo system. 
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The following parameters, statuses and commands apply to this window: 
 

Description 
Set system gain in proportion to speed response level automatically by referring the estimated inertia ratio after 
auto tuning. 

Parameter [Ft-1.00] 

Range: 1~150 

Default: 50 

Units: % 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

Description 

• A higher value results in higher position/speed/torque related gain values and higher responsiveness. 
(However, excessive values can result in noise and vibrations) 
• Conversely, lower values result in smaller gain and lower responsiveness; however, the whole system‟s stability 
is increased. 
• Refers to the bandwidth of  the entire speed control loop. 
• When this value is changed, the gain values [Ft-1.02], [Ft-1.03], [Ft-1.06],[Ft-1.07], [Ft-1.08] are set 
automatically according to the control mode while referring to the inertia ratio parameter [Ft-0.04]. 
•The lower limit is 10 [Hz]. 

Parameter [Ft-1.01] 

Range: 10~500 

Default: 50 

Units: Hz 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

 

Drive - Tuning - Main Velocity Regulator Gains-P 

Description 
Proportional gain for the velocity loop. The P gain generates a control signal proportional to the velocity error.  
Note: Increasing the P gain improves response time and increases the stiffness of  the system. Too high a P 
gain value causes instability; too low a P gain value results in loose or sloppy system dynamics. 

Parameter [Ft-1.02] 

Range: 0~10000 

Default: 60 

Units: - 

Applicable 
Operating 
Mode: 

Follower, Analog Speed, Preset 

When Enabled Immediately 

Description 

Integral gain for the velocity loop. The I gain generates a control signal proportional to the integral of  the 
velocity error.  
Note: I gain improves the steady-state velocity performance of  the system. Increasing the integral gain 
generally increases the ultimate positioning accuracy of  the system. However excessive integral gain results in 
system instability. 

Parameter [Ft-1.03] 

Range: 0~60000 
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Default: 26 

Units: - 

Applicable 
Operating 
Mode: 

Follower, Analog Speed, Preset 

When Enabled Immediately 

Description 
During transient response, Speed Response Overshoot can be suppressed by speed controller change from 
Proportion Integration (PI) Controller into Proportion (P) Controller. It reduces Position completion time 
during Position Control. 

Parameter [Ft-1.17] 

Range: 

Select  Description Value  

Always On Do not use P/PI Mode Conversion. 0x0 

High Current 
Disable 

When Current Command exceeds Current Value in [Ft-
1.18], Speed Controller is changed from PI Controller to 
P Controller. 

0x1 

Velocity Command 
Disable 

When Speed Command exceeds Speed Value in [Ft-1.18], 
Speed Controller is changed from PI Controller to P 
Controller. 

0x2 

Position Error 
Disable 

When Position error exceeds Position error Value in [Ft-
1.18], Speed Controller is changed from PI Controller to 
P Controller. 

0x3 

Automatic Disable 
Automatically velocity controller is changed from PI 
Controller to P Controller. 

0x4 

Default: Always On 

Applicable 
Operating 
Mode: 

ALL 

When Enabled Servo-Off  -> Setting 

Description 
If  the speed torque command or the position tolerance exceeds the value set in this parameter, the speed 
controller changes from PI type to P type 

Parameter [Ft-1.18] 

Range: 0~3000 

Default: 100 

Units: 

If  [Ft-1.17] = 1, units are % of  rated continuous current 
If  [Ft-1.17] = 2, units are RPM for rotary motors 
              units are mm/sec for linear motors 
If  [Ft-1.17] = 3, units are Counts 

Applicable 
Operating 
Mode: 

Follower, Analog Velocity, Preset 

When Enabled Immediately 

Description 

Derivative gain value for the velocity loop. The D gain generates a control signal proportional to measured 
acceleration.  
Note: Positive D gain reduces velocity overshoot, and negative D gain should be used only in systems that 
exhibit mechanical resonance. 

Parameter [Ft-1.04] 

Range: 0~1000 

Default: 0 

Units: - 
Applicable 
Operating 
Mode: 

Follower, Analog Velocity, Preset 
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When Enabled Immediately 

Description 
• The low pass of  velocity command and setting the cutoff  frequency to suppress high frequency components. 
• System gain value will change its value. 

Parameter [Ft-1.08] 

Range: 0~10000 

Default: 1000 

Units: Hz 

Applicable 
Operating 
Mode: 

Follower, Analog Speed, Preset 

When Enabled Immediately 

Drive - Tuning - Main Velocity Regulator Gains-Error Filter Bandwidth 

Description High frequency components of  the velocity error are filtered. 

Parameter [Ft-1. 05] 

Range: 0~2500 

Default: 30 

Units: Hz 

Applicable 
Operating 
Mode: 

Follower, Analog Velocity, Preset 

When Enabled Immediately 

 

Drive - Tuning - Main Position Regulator Gains-Kp 

Description 

Proportional gain for the position loop. The Kp gain generates a control signal proportional to the position 
error.  
Note: Increasing the Kp gain improves response time and increases the stiffness of  the system. Too high a Kp 
gain value causes instability; too low a Kp gain value results in loose or sloppy system dynamics. 

Parameter [Ft-1.06] 

Range: 0~700 

Default: 20 

Units: Hz 

Applicable 
Operating 
Mode: 

Follower 

When Enabled Immediately 

Description 
Feedforward gain for the position loop.The Kff  gain generates a feed forward signal proportional to the 
commanded speed.  
Note: Kff  gain reduces position following error. However high values can cause position overshoot. 

Parameter [Ft-1.15] 

Range: 0~100 

Default: 0 

Units: % 

Applicable 
Operating 
Mode: 

Follower 

When Enabled Immediately 

Drive - Tuning - Main Position Regulator Gains-Kff  Low Pass Filter Bandwidth 

Description 
• Valid if  position FF gain [Ft-1.15] is not „0‟. 
• If  a value other than „0‟ set for [Ft-1.15] results in overshoot or vibration, set this value to „0‟. 
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Parameter [Ft-1.16] 

Range: 0~2500 

Default: 200 

Units: Hz 

Applicable 
Operating 
Mode: 

Follower 

When Enabled Immediately 

Description 
The connected drive's low pass filter's bandwidth. This value indicates the cutoff  frequency of  the low pass 
filter. 
Note: This filter reduces noise generated by encoder resolution or mechanical resonance in the system. 

Parameter [Ft-1.09] 

Range: 0~10000 

Default: 0 

Units: Hz 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

Description 
When the position error is greater than the value of  High Error Output Threshold, this constant velocity Bias 
will be input into the velocity controller. 

Parameter [Ft-1.19] 

Range: 0~450 

Default: 0 

Units: Rotary: RPM, Linear: mm/sec 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

Description The value of  velocity bias is error standard value inputted into velocity controller. 

Parameter [Ft-1.20] 

Range: 0~50000 

Default: 1000 

Units: Counts 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

 

Drive - Tuning - Main Current Regulator Gains - Gain 

Description The bandwith for current control. 

Parameter [Ft-1.21] 

Range: 

Select Description Value 

High High bandwidth  0x0 

Medium Medium bandwidth (0.6667 * high) 0x1 

Low Low bandwidth (0.3334 * high) 0x2 

Default: Medium 

Units:  
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Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

Description 
To suppress high frequency compents of  the current command. 
It will be changed by the system gain value. 

Parameter [Ft-1.07] 

Range: 0~10000 

Default: 300 

Units: Hz 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

Description Suppresses Vibration by cutting off  Current Command in assigned frequency band 

Parameter [Ft-1.10] 

Range: 0~10000 

Default: 10000 

Units: Hz 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

Description Suppresses Vibration by cutting off  Current Command in assigned frequency band 

Parameter [Ft-1.12] 

Range: 0~10000 

Default: 10000 

Units: Hz 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

Description 
Set up the notch width of  the 1st resonance suppressing filter in 20 steps. Higher the setup, larger the notch 
width you can obtain. 

Parameter [Ft-1.11] 

Range: 0~20 

Default: 10 

Units: - 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

Description 
Set up the notch width of  2nd resonance suppressing filter in 20 steps. Higher the setup, larger the notch 
width you can obtain. 

Parameter [Ft-1.13] 

Range: 0~20 
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Default: 10 

Units: - 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

Description 
Set up the 2nd notch depth of  the resonance suppressing filter. Higher the setup, shallower the notch depth 
and smaller the phase delay you can obtain. 

Parameter [Ft-1.14] 

Range: 0~100 

Default: 100 

Units: - 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

 

Drive - Tuning – Autotuning - Autotuning Speed 

Description The larger the setting value, the higher speed. 

Parameter [Ft-0.03]-Digit2 

Range: 200~900 

Default: 700 

Units: RPM 

Applicable 
Operating 
Mode: 

All 

When Enabled Servo-Off  -> Setting 

Drive - Tuning – Autotuning - Off-Line Tuning Mode 

Description Select Off-Line autotuning mode 

Parameter [Ft-0.03]-Digit0 

Range: 

Select Description Value 

Inertia Moment Estimation Inertia Moment Estimation 0x0 

Inertia Moment Estimation 
and Resonant Frequency 
Detection 

Inertia Moment Estimation and Resonant 
Frequency Detection 

0x1 

Resonance frequency 
Detection 

Resonance frequency Detection 0x2 

Default: Inertia Moment Estimation and Resonant Frequency Detection 

Applicable 
Operating 
Mode: 

All 

When Enabled Servo-Off  -> Setting 

Description Select On-Line vibration suppression mode 

Parameter [Ft-1.22]-Digit0 

Range: 

Select Description Value 

Disable Disable 0x0 

Normal and High Velocity 
Mode 

Normal and High Velocity Mode 0x1 

Slow Velocity without initial 
value 

Slow Velocity Mode without initial value 0x2 
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Default: Disable 

Applicable 
Operating 
Mode: 

All 

When Enabled Servo-Off  -> Setting 

Description Select On-Line vibration suppression gain 

Parameter [Ft-1.22] 

Range: 

Select Description Value 

Low Low 0x0 

High High 0x1 

Default: Low 

Applicable 
Operating 
Mode: 

All 

When Enabled Servo-Off  -> Setting 

 

Drive - Tuning – Velocity Regulator Configuration- Velocity Command Filter on Follower 

Description Select to make velocity command low pass filter take effect in follower mode 

Parameter [Ft-1.23]-Digit0 

Range: 

Select Description Value 

Disable Disable 0x0 

Enable Enable 0x1 

Default: Disable 

Applicable 
Operating 
Mode: 

All 

When Enabled Servo-Off  -> Setting 

 

Drive - Tuning – Gain Switching - Gain Change Enable 

Description When gain value is switched from Second gain to first gain, you can set delay time. 

Parameter [Ft-0.05]-Digit2 

Range: 

Select Description Value 

Disable Disable 0x0 

Enable Enable 0x1 

Default: Disable 

Applicable 
Operating 
Mode: 

All 

When Enabled Servo-Off  -> Setting -> After power cycle 

Description Select the gain switching mode 

Parameter [Ft-0.06]-Digit2 

Range: 

Select Description Value 

1st Gain Fix Fixed to the 1st gain 0x0 

2nd Gain Fix Fixed to 2nd gain 0x1 

Digital Input (G-
SEL) 

2nd gain selection when the gain switching input is turned 
on. 

0x2 

Torque Command 
2nd gain selection when the toque command is larger than 
the setups (level of  gain control switching and hysteresis of  
control switching) 

0x3 
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Velocity Command 
2nd gain selection when the command speed is larger than 
the setups (level of  gain control switching and hysteresis of  
control switching) 

0x4 

Position Error 
2nd gain selection when the positional deviation is larger 
than the setups (level of  gain control switching and hysteresis 
of  control switching) 

0x5 

Position 
Command 

2nd gain selection when more then one command pulse exist 
between 200usec. 

0x6 

In-Position 
2nd gain selection when the positional deviation counter 
value exceeds the setup of  Positioning completer range 

0x7 

Velocity 

2nd gain selection when the motor actual speed exceeds the 
setup (level of  gain control switching and hysteresis of  
control switching). 
Switches to the 2nd gain while the position command exists. 

0x8 

Position command 
and Speed 

Switches to the 1st gain when no-position command status 
lasts for the setup of  delay time of  gain switching [x 200usec] 
and the speed falls slower than the setups of  gain control 
switching level and hysteresis of  control switching 

0x9 

Default: 1st Gain Fix 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

Description When gain value is switched from Second gain to first gain, you can set delay time. 

Parameter [Ft-1.24] 

Range: 0~10000 

Default: 0 

Units: x 200usec 

Applicable 
Operating 
Mode: 

Follower, Analog Velocity, Preset 

When Enabled Immediately 

Drive - Tuning – Gain Switching - Level of  Gain Switching 

Description Set standard value for gain switching. The setting value is for Gain Switching Mode ([Ft-0.06]-Digit2). 

Parameter [Ft-1.25] 

Range: 0~10000 

Default: 0 

Units: - 

Applicable 
Operating 
Mode: 

Follower, Analog Velocity, Preset 

When Enabled Immediately 

Description 
Operates Hysteresis based on operation level when gain switching. The setting value is for Gain Switching 
Mode ([Ft-0.06]-Digit1). 

Parameter [Ft-1.26] 

Range: 0~10000 

Default: 0 

Units: - 

Applicable 
Operating 
Mode: 

Follower, Analog Velocity, Preset 

When Enabled Immediately 
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Description Adjust as Position Gain Switching Time step by step when switching gain value from first gain to second gain. 

Parameter [Ft-1.27] 

Range: 0~10000 

Default: 0 

Units: x 200µsec 

Applicable 
Operating 
Mode: 

Follower, Analog Velocity, Preset 

When Enabled Immediately 

 

Drive - Tuning – 2nd Regulator Gains - P 

Description Parameter which determines the responsiveness of  speed control 

Parameter [Ft-1.28] 

Range: 0-10000 

Default: 60 

Units: - 

Applicable 
Operating 
Mode: 

Follower, Analog Velocity, Preset 

When Enabled Immediately 

Description 
• Removes steady state speed tolerance. 
• Overshoot in speed response can occur if  set value is too large. 

Parameter [Ft-1.29] 

Range: 0~60000 

Default: 26 

Units: - 

Applicable 
Operating 
Mode: 

Follower, Analog Velocity, Preset 

When Enabled Immediately 

Description Sets low pass cutoff  frequency of  speed command to suppress high frequency components. 

Parameter [Ft-1.32] 

Range: 0~10000 

Default: 1000 

Units: Hz 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

Description 
• Parameter which determines the responsiveness of  position control 
• Change set value according to rigidity of  load 

Parameter [Ft-1.30] 

Range: 0~700 

Default: 20 

Units: Hz 

Applicable 
Operating 
Mode: 

Position 

When Enabled Immediately 
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Description Suppresses high frequency components of  torque command 

Parameter [Ft-1.31] 

Range: 0~10000 

Default: 300 

Units: Hz 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

 

Drive - Tuning – 3rd Regulator Gains - P

Description Parameter which determines the responsiveness of  speed control 

Parameter [Ft-1.33] 

Range: 0-10000 

Default: 60 

Units: - 

Applicable 
Operating 
Mode: 

Follower, Analog Velocity, Preset 

When Enabled Immediately 

Description 
• Removes steady state speed tolerance. 
• Overshoot in speed response can occur if  set value is too large. 

Parameter [Ft-1.34] 

Range: 0~60000 

Default: 26 

Units: - 

Applicable 
Operating 
Mode: 

Follower, Analog Velocity, Preset 

When Enabled Immediately 

Description Sets low pass cutoff  frequency of  speed command to suppress high frequency components. 

Parameter [Ft-1.37] 

Range: 0~10000 

Default: 1000 

Units: Hz 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

Description 
• Parameter which determines the responsiveness of  position control 
• Change set value according to rigidity of  load 

Parameter [Ft-1.35] 

Range: 0~700 

Default: 20 

Units: Hz 

Applicable 
Operating 
Mode: 

Position 
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When Enabled Immediately 

Description Suppresses high frequency components of  torque command 

Parameter [Ft-1.36] 

Range: 0~10000 

Default: 300 

Units: Hz 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

 

Drive - Tuning – 4th Regulator Gains - P 

Description Parameter which determines the responsiveness of  speed control 

Parameter [Ft-1.38] 

Range: 0-10000 

Default: 60 

Units: - 

Applicable 
Operating 
Mode: 

Follower, Analog Velocity, Preset 

When Enabled Immediately 

Description 
• Removes steady state speed tolerance. 
• Overshoot in speed response can occur if  set value is too large. 

Parameter [Ft-1.39] 

Range: 0~60000 

Default: 26 

Units: - 

Applicable 
Operating 
Mode: 

Follower, Analog Velocity, Preset 

When Enabled Immediately 

Description Sets low pass cutoff  frequency of  speed command to suppress high frequency components. 

Parameter [Ft-1.42] 

Range: 0~10000 

Default: 1000 

Units: Hz 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

Description 
• Parameter which determines the responsiveness of  position control 
• Change set value according to rigidity of  load 

Parameter [Ft-1.40] 

Range: 0~700 

Default: 20 

Units: Hz 

Applicable 
Operating 

Position 
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Mode: 

When Enabled Immediately 

Description Suppresses high frequency components of  torque command 

Parameter [Ft-1.41] 

Range: 0~10000 

Default: 300 

Units: Hz 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

 

The following statuses are displayed by default for the Tuning branch of an on-
line drive: 

Velocity Loop 

Command Velocity The commanded motor velocity. 

Feedback Velocity The actual motor velocity. 

Error 
The difference between commanded motor velocity 
(Velocity Command) and actual motor velocity (Velocity 
Motor Feedback). 

Position Loop 

Master Position The commanded motor position 

Follower Position The actual motor position 

Error 
The difference between commanded motor position 
(Position Command) and actual motor position (Position 
Feedback). 

Current Loop 

Command Current The commanded current. 

 
The following commands can be executed for a Motor branch of an on-line 
drive: 
 

Start Auto tuning Begins the Autotuning procedure 

Copy Main Gains To 2nd Gains This command sets the values in the 2nd, 3rd, and 
4th Gain Values section by copying the values set 
in Main Gains. 
Note: For KNX3 Drive, the command is “Copy 
Main Gains To Alternate”. 

Copy Main Gains To 3rd Gains 

Copy Main Gains To 4th Gains 

Copy Main Gains To all Gains 

Save Parameters 
Saves the current working values as power-up 
values in flash memory for the selected On-Line 
drive and all of its children 

 
Customize the Manual Velocity Tuning window for your CSD5 Drive branch 
by selecting one or more of the following buttons: 
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• Toggle the Show Status selection to display or hide the Status pane. 

• Toggle the Show Commands selection to display or hide the 
Commands pane. 

• Click on the Revert button to return parameter settings to the values 
they held when you opened this window. 

The Properties window for Encoders looks like this: 

Note: The Properties window for Encoders of CSD5 Drive and KNX3 Drive 
are not same. The below is an illustration of CSD5 Drive. 

 

Use the Encoders window to describe the motor and auxiliary encoders, by: 

• configuring the motor encoder. 

This window has the following parameters: 
 

Description Configure Encoder Output Forward Direction 

Parameter [Ft-3.00]-Digit2 

Range: 

Select: Description Value 

A Leads B 
During Forward Rotation, Encoder Output Phase A have a 

 
0x0 

B Leads A 
During Forward Rotation, Encoder Output Phase B have a 

 
0x1 

Default: A Leads B 

Applicable 
Operating 
Mode: 

Follower 

When Enabled Servo-Off  -> Setting 
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Description 

First number: Denominator of  Position output pulse adjustment. 
Second number: Numerator of  Position output pulse adjustment. 
• Sets the number of  pulses to be output through the servo drive‟s encoder signal output (EA+, EA-, EB+, 
EB-) for one motor rotation. 
• At [Ft-3.03], the numerator of  the encoder‟s output divider ratio is entered. Generally, the number of  pulses 
to be output at 1 motor rotation is entered. 
• At [Ft-3.04], the denominator of  the encoder‟s output divider ratio is entered. Generally, the number of  
pulses output from the encoder connected to the motor for 1 rotation is entered. 
• For the encoder output division ratio, the relationship [Ft-3.03]≤[Ft-3.04] has to be satisfied. 
• For the No. of  output pulses per rotation to the higher level controller: 
([Ft-3.03]/[Ft-3.04]) ×  . of  output pulses per rotation = Output to higher level controller 

Parameter [Ft-3.04]-First number, [Ft-3.04]-second number 

Range: 1~32768 

Default: 1:1 

Units: Output Counts : Motor Counts 

Applicable 
Operating 
Mode: 

All 

When Enabled Servo-Off  -> Setting 

Description Sets whether battery should be used when using serial absolute value encoder. 

Parameter [Ft-0.05]-Digit0 

Range: 

Select: Description Value 

Installed Backup Battery Installed 0x0 

Not Installed Backup Battery Not Installed 0x1 

Default: Installed 

Applicable 
Operating 
Mode: 

All 

When Enabled Servo-Off  -> Setting -> After power cycle 

Description Define the polarity of  absolute encoder data 

Parameter [Ft-0.06]-Digit3 

Range: 

Select: Description Value 

Same as Command 
Polarity 

Absolute encoder data‟s polarity is changed by command 
Polarity 

0x0 

Always CCW 
Absolute encoder data‟s polarity is fixed as CCW 
direction 

0x1 

Always CW Absolute encoder data‟s polarity is fixed as CC direction 0x2 

Default: Same as Command Polarity 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

 
The following commands can be executed on an on-line drive using the 
Encoders window: 
 

Absolute Encoder Reset Reset Absolute Encoder 

Save Parameters Save Parameters 
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Customize the Encoders window for your CSD5 Drive branch by selecting one 
or more of the following buttons: 

• Toggle the Show Status selection to display or hide the Status pane. 

• Toggle the Show Commands selection to display or hide the 
Commands pane. 

• Click on the Setup button to open the Monitor Setup window as shown 
on page 112, where you can customize the status display for this window. 

• Click on the Revert button to return parameter settings to the values 
they held when you opened this window. 

The Properties window for Digital Inputs looks like this: 

Note: The Properties window for Digital Inputs of KNX3 and CSD5 look like 
same, but the input setting is different. For One Input, only one can set for 
CSD5 Drive, but many more can be set for KNX3 Drive. 

 
 
Use the Digital Inputs window to: 

• assign functionality to digital inputs, and 

• monitor the status of digital inputs. 

Selecting a function in the Value selection box causes that function to become 
active when the associated Digital Input becomes active. 
 

 

By default, Input 1 is assigned the function Drive Enable. If 
you change the assignments so that Drive Enable is not 
assigned to any input, the drive automatically enable on 
power-up. Be aware that, in this case, the motor may start 
moving on power-up. 
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Note: Preset Selects 0 through 5 are a special case. Instead of activating a 
function, Preset Selects 1 through 6 contributes a binary value when a digital 
input becomes active. The drive sums the binary values and uses the resulting 
integer to determine which Preset Position, Preset Velocity, Preset Current, 
Preset Follower Gearing Ratio or Index is used. 

 
The digital input Preset Select binary values are as follows: 

• Preset Select 1 = 1 if active, 0 if not. 

• Preset Select 2 = 2 if active, 0 if not. 

• Preset Select 3 = 4 if active, 0 if not. 

• Preset Select 4 = 8 if active, 0 if not. 

• Preset Select 5 = 16 if active, 0 if not. 

• Preset Select 6 = 32 if active, 0 if not. 

If a Preset Select is not assigned to a digital input, the Preset Select is 
considered inactive. 

 
The drive uses only the Preset Select 1, 2 and3 binary values (yielding values 
1~7) when the drive's Operation mode is set to Preset Position, Preset Velocity, 
Preset Current and Preset Follower (Gearing Ratio). 
 
The drive uses all six Preset Select binary values (yielding values 0~ 63) when 
the drive's Operation mode is set to Indexing. 
 
There are no commands associated with the Digital Inputs parameter window. 
This window has the following parameters and statuses:  
 

Description Select the drive's digital input assignments. 

Parameter [Ft-0.22]~ [Ft-0.27] 

Range: 

Select: Description Value 

Unassigned Unassigned  

Alternate Gain 
Select 

Alternate Gain Select(G-SEL) [Ft-0.13]-Digit2 

Current Limit - 
Positive 

Positive Current Limit(P-TL) [Ft-0.11]-Digit2 

Current Limit - 
Negative 

Negative Current Limit(N-TL) [Ft-0.11]-Digit1 

Drive Enable Drive Enable(SV-ON)  [Ft-0.10]-Digit0 

Fault Reset Fault Reset(A-RST) [Ft-0.11]-Digit0 

Integrator Inhibit Integrator Inhibit(P-CON) [Ft-0.10]-Digit3 

Operation Mode 
Override 

Operation Mode Override(C-SEL) [Ft-0.11]-Digit3 

Overtravel - 
Negative 

Negative Over-travel(N-OT) [Ft-0.10]-Digit2 

Overtravel - Positive Positive Over-travel(P-OT) [Ft-0.10]-Digit1 

Pause Follower Pause Follower(INHIBIT) [Ft-0.13]-Digit1 

Position Strobe Position Strobe(ABS-DT) [Ft-0.14]-Digit0 
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Velocity Direction Preset Direction(C-DIR) [Ft-0.12]-Digit0 

Preset Select 1 Preset Select 1(C-SP1) [Ft-0.12]-Digit1 

Preset Select 2 Preset Select 2(C-SP2) [Ft-0.12]-Digit2 

Preset Select 3 Preset Select 3(C-SP3) [Ft-0.12]-Digit3 

Reset Multiturn Data Reset multi-turn data of  Absolute Encoder(R-ABS) [Ft-0.15]-Digit0 

Zero Speed Clamp 
Enable 

Zero Speed Clamp Enable(Z-CLP) [Ft-0.13]-Digit0 

Position Clear Position clear(PCLR) [Ft-0.13]-Digit3 

Moving Enable Motor Moving Enable (START). [Ft-0.14]-Digit1 

Analog Speed 
Command Enable 

Analog Speed Command Select (C-SP4) [Ft-0.14]-Digit2 

2nd Electronic Gear 
Bank Selection 

2nd Electronic Gear Bank Selection(GEAR) [Ft-0.14]-Digit3 

Home Sensor Home Sensor(H-SENS) [Ft-0.16]-Digit0 

Start Homing Start Homing(SHOME) [Ft-0.16]-Digit1 

Stop Indexing Stop Indexing(STOP) [Ft-0.16]-Digit2 

Pause Indexing Pause Indexing(PAUSE) [Ft-0.16]-Digit3 

Index Select0 Input Index Select 0 Input(I-SEL0) [Ft-0.17]-Digit0 

Index Select1 Input Index Select 1 Input(I-SEL1) [Ft-0.17]-Digit1 

Index Select2 Input Index Select 2 Input(I-SEL2) [Ft-0.17]-Digit2 

Index Select3 Input Index Select 3 Input(I-SEL3) [Ft-0.17]-Digit3 

Index Select4 Input Index Select 4 Input(I-SEL4) [Ft-0.18]-Digit0 

Index Select5 Input Index Select 5 Input(I-SEL5) [Ft-0.18]-Digit1 

Stop Homing Stop Homing(H-STOP)  [Ft-0.18]-Digit2 

Start Indexing Start Index(START-I) [Ft-0.18]-Digit3 

Current Limit-
Analog 

Analog Current Limit(A-CL) [Ft-0.15]-Digit1 

Absolute Position 
Transfer Mode 

Absolute Position Transfer Mode(ABS-MD) 

 
Please refer to the above content. 

[Ft-0.15]-Digit2  

Current Limit-
Analog 

Analog Current Limit(A-CL) 
Note: This parameter is only added for CSD5 Drive 

[Ft-0.15]-Digit3 

Default: Drive Enable 

Applicable 
Operating 
Mode: 

All 

When Enabled Servo-Off  -> Setting 

Description Select the drive's digital input assignments. 

Parameter [Ft-0.22]~ [Ft-0.27] 

Range: 

Select: Description Value 

Unassigned Unassigned  

Alternate Gain 
Select 

Alternate Gain Select(G-SEL) [Ft-0.13]-Digit2 

Current Limit - 
Positive 

Positive Current Limit(P-TL) [Ft-0.11]-Digit2 

Current Limit - 
Negative 

Negative Current Limit(N-TL) [Ft-0.11]-Digit1 

Drive Enable Drive Enable(SV-ON) [Ft-0.10]-Digit0 

Fault Reset Fault Reset(A-RST) [Ft-0.11]-Digit0 

Integrator Inhibit Integrator Inhibit(P-CON) [Ft-0.10]-Digit3 
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Operation Mode 
Override 

Operation Mode Override(C-SEL) [Ft-0.11]-Digit3 

Overtravel - 
Negative 

Negative Over-travel(N-OT) [Ft-0.10]-Digit2 

Overtravel - Positive Positive Over-travel(P-OT) [Ft-0.10]-Digit1 

Pause Follower Pause Follower(INHIBIT) [Ft-0.13]-Digit1 

Position Strobe Position Strobe(ABS-DT) [Ft-0.14]-Digit0 

Velocity Direction Preset Direction(C-DIR) [Ft-0.12]-Digit0 

Preset Select 1 Preset Select 1(C-SP1) [Ft-0.12]-Digit1 

Preset Select 2 Preset Select 2(C-SP2) [Ft-0.12]-Digit2 

Preset Select 3 Preset Select 3(C-SP3) [Ft-0.12]-Digit3 

Reset Multiturn Data Reset multi-turn data of  Absolute Encoder(R-ABS) [Ft-0.15]-Digit0 

Zero Speed Clamp 
Enable 

Zero Speed Clamp Enable(Z-CLP) [Ft-0.13]-Digit0 

Position Clear Position clear(PCLR) [Ft-0.13]-Digit3 

Moving Enable Motor Moving Enable (START). [Ft-0.14]-Digit1 

Analog Speed 
Command Enable 

Analog Speed Command Select (C-SP4) [Ft-0.14]-Digit2 

2nd Electronic Gear 
Bank Selection 

2nd Electronic Gear Bank Selection(GEAR) [Ft-0.14]-Digit3 

Home Sensor Home Sensor(H-SENS) [Ft-0.16]-Digit0 

Start Homing Start Homing(SHOME) [Ft-0.16]-Digit1 

Stop Indexing Stop Indexing(STOP) [Ft-0.16]-Digit2 

Pause Indexing Pause Indexing(PAUSE) [Ft-0.16]-Digit3 

Index Select0 Input Index Select 0 Input(I-SEL0) [Ft-0.17]-Digit0 

Index Select1 Input Index Select 1 Input(I-SEL1) [Ft-0.17]-Digit1 

Index Select2 Input Index Select 2 Input(I-SEL2) [Ft-0.17]-Digit2 

Index Select3 Input Index Select 3 Input(I-SEL3) [Ft-0.17]-Digit3 

Index Select4 Input Index Select 4 Input(I-SEL4) [Ft-0.18]-Digit0 

Index Select5 Input Index Select 5 Input(I-SEL5) [Ft-0.18]-Digit1 

Stop Homing Stop Homing(H-STOP)  [Ft-0.18]-Digit2 

Start Indexing Start Index(START-I) [Ft-0.18]-Digit3 

Current Limit-
Analog 

Analog Current Limit(A-CL) [Ft-0.15]-Digit1 

Absolute Position 
Transfer Mode 

Absolute Position Transfer Mode(ABS-MD) 

 
Please refer to the above content. 

[Ft-0.15]-Digit2  

Current Limit-
Analog 

Analog Current Limit(A-CL) 
Note: This parameter is only added for CSD5 Drive 

[Ft-0.15]-Digit3 

Default: Home Sensor 

Applicable 
Operating 
Mode: 

All 

When Enabled Servo-Off  -> Setting 

Description Select the drive's digital input assignments. 

Parameter [Ft-0.22]~ [Ft-0.27] 

Range: 

Select: Description Value 

Unassigned Unassigned  

Alternate Gain 
Select 

Alternate Gain Select(G-SEL) [Ft-0.13]-Digit2 
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Current Limit - 
Positive 

Positive Current Limit(P-TL) [Ft-0.11]-Digit2 

Current Limit - 
Negative 

Negative Current Limit(N-TL) [Ft-0.11]-Digit1 

Drive Enable Drive Enable(SV-ON) [Ft-0.10]-Digit0 

Fault Reset Fault Reset(A-RST) [Ft-0.11]-Digit0 

Integrator Inhibit Integrator Inhibit(P-CON) [Ft-0.10]-Digit3 

Operation Mode 
Override 

Operation Mode Override(C-SEL) [Ft-0.11]-Digit3 

Overtravel - 
Negative 

Negative Over-travel(N-OT) [Ft-0.10]-Digit2 

Overtravel - Positive Positive Over-travel(P-OT) [Ft-0.10]-Digit1 

Pause Follower Pause Follower(INHIBIT) [Ft-0.13]-Digit1 

Position Strobe Position Strobe(ABS-DT) [Ft-0.14]-Digit0 

Velocity Direction Preset Direction(C-DIR) [Ft-0.12]-Digit0 

Preset Select 1 Preset Select 1(C-SP1) [Ft-0.12]-Digit1 

Preset Select 2 Preset Select 2(C-SP2) [Ft-0.12]-Digit2 

Preset Select 3 Preset Select 3(C-SP3) [Ft-0.12]-Digit3 

Reset Multiturn Data Reset multi-turn data of  Absolute Encoder(R-ABS) [Ft-0.15]-Digit0 

Zero Speed Clamp 
Enable 

Zero Speed Clamp Enable(Z-CLP) [Ft-0.13]-Digit0 

Position Clear Position clear(PCLR) [Ft-0.13]-Digit3 

Moving Enable Motor Moving Enable (START). [Ft-0.14]-Digit1 

Analog Speed 
Command Enable 

Analog Speed Command Select (C-SP4) [Ft-0.14]-Digit2 

2nd Electronic Gear 
Bank Selection 

2nd Electronic Gear Bank Selection(GEAR) [Ft-0.14]-Digit3 

Home Sensor Home Sensor(H-SENS) [Ft-0.16]-Digit0 

Start Homing Start Homing(SHOME) [Ft-0.16]-Digit1 

Stop Indexing Stop Indexing(STOP) [Ft-0.16]-Digit2 

Pause Indexing Pause Indexing(PAUSE) [Ft-0.16]-Digit3 

Index Select0 Input Index Select 0 Input(I-SEL0) [Ft-0.17]-Digit0 

Index Select1 Input Index Select 1 Input(I-SEL1) [Ft-0.17]-Digit1 

Index Select2 Input Index Select 2 Input(I-SEL2) [Ft-0.17]-Digit2 

Index Select3 Input Index Select 3 Input(I-SEL3) [Ft-0.17]-Digit3 

Index Select4 Input Index Select 4 Input(I-SEL4) [Ft-0.18]-Digit0 

Index Select5 Input Index Select 5 Input(I-SEL5) [Ft-0.18]-Digit1 

Stop Homing Stop Homing(H-STOP)  [Ft-0.18]-Digit2 

Start Indexing Start Index(START-I) [Ft-0.18]-Digit3 

Current Limit-
Analog 

Analog Current Limit(A-CL) [Ft-0.15]-Digit1 

Absolute Position 
Transfer Mode 

Absolute Position Transfer Mode(ABS-MD) 

 
Please refer to the above content. 

[Ft-0.15]-Digit2  

Current Limit-
Analog 

Analog Current Limit(A-CL) 
Note: This parameter is only added for CSD5 Drive 

[Ft-0.15]-Digit3 

Default: Start Homing 

Applicable 
Operating 
Mode: 

All 

When Enabled Servo-Off  -> Setting 

Description Select the drive's digital input assignments. 
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Parameter [Ft-0.22]~ [Ft-0.27] 

Range: 

Select: Description Value 

Unassigned Unassigned  

Alternate Gain 
Select 

Alternate Gain Select(G-SEL) [Ft-0.13]-Digit2 

Current Limit - 
Positive 

Positive Current Limit(P-TL) [Ft-0.11]-Digit2 

Current Limit - 
Negative 

Negative Current Limit(N-TL) [Ft-0.11]-Digit1 

Drive Enable Drive Enable(SV-ON) [Ft-0.10]-Digit0 

Fault Reset Fault Reset(A-RST) [Ft-0.11]-Digit0 

Integrator Inhibit Integrator Inhibit(P-CON) [Ft-0.10]-Digit3 

Operation Mode 
Override 

Operation Mode Override(C-SEL) [Ft-0.11]-Digit3 

Overtravel - 
Negative 

Negative Over-travel(N-OT) [Ft-0.10]-Digit2 

Overtravel - Positive Positive Over-travel(P-OT) [Ft-0.10]-Digit1 

Pause Follower Pause Follower(INHIBIT) [Ft-0.13]-Digit1 

Position Strobe Position Strobe(ABS-DT) [Ft-0.14]-Digit0 

Velocity Direction Preset Direction(C-DIR) [Ft-0.12]-Digit0 

Preset Select 1 Preset Select 1(C-SP1) [Ft-0.12]-Digit1 

Preset Select 2 Preset Select 2(C-SP2) [Ft-0.12]-Digit2 

Preset Select 3 Preset Select 3(C-SP3) [Ft-0.12]-Digit3 

Reset Multiturn Data Reset multi-turn data of  Absolute Encoder(R-ABS) [Ft-0.15]-Digit0 

Zero Speed Clamp 
Enable 

Zero Speed Clamp Enable(Z-CLP) [Ft-0.13]-Digit0 

Position Clear Position clear(PCLR) [Ft-0.13]-Digit3 

Moving Enable Motor Moving Enable (START). [Ft-0.14]-Digit1 

Analog Speed 
Command Enable 

Analog Speed Command Select (C-SP4) [Ft-0.14]-Digit2 

2nd Electronic Gear 
Bank Selection 

2nd Electronic Gear Bank Selection(GEAR) [Ft-0.14]-Digit3 

Home Sensor Home Sensor(H-SENS) [Ft-0.16]-Digit0 

Start Homing Start Homing(SHOME) [Ft-0.16]-Digit1 

Stop Indexing Stop Indexing(STOP) [Ft-0.16]-Digit2 

Pause Indexing Pause Indexing(PAUSE) [Ft-0.16]-Digit3 

Index Select0 Input Index Select 0 Input(I-SEL0) [Ft-0.17]-Digit0 

Index Select1 Input Index Select 1 Input(I-SEL1) [Ft-0.17]-Digit1 

Index Select2 Input Index Select 2 Input(I-SEL2) [Ft-0.17]-Digit2 

Index Select3 Input Index Select 3 Input(I-SEL3) [Ft-0.17]-Digit3 

Index Select4 Input Index Select 4 Input(I-SEL4) [Ft-0.18]-Digit0 

Index Select5 Input Index Select 5 Input(I-SEL5) [Ft-0.18]-Digit1 

Stop Homing Stop Homing(H-STOP)  [Ft-0.18]-Digit2 

Start Indexing Start Index(START-I) [Ft-0.18]-Digit3 

Current Limit-
Analog 

Analog Current Limit(A-CL) [Ft-0.15]-Digit1 

Absolute Position 
Transfer Mode 

Absolute Position Transfer Mode(ABS-MD) 

 
Please refer to the above content. 

[Ft-0.15]-Digit2  

Current Limit-
Analog 

Analog Current Limit(A-CL) 
Note: This parameter is only added for CSD5 Drive 

[Ft-0.15]-Digit3 

Default: Start Indexing 

Applicable All 
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Operating 
Mode: 

  

When Enabled Servo-Off  -> Setting 

Description Select the drive's digital input assignments. 

Parameter [Ft-0.22]~ [Ft-0.27] 

Range: 

Select: Description Value 

Unassigned Unassigned  

Alternate Gain 
Select 

Alternate Gain Select(G-SEL) [Ft-0.13]-Digit2 

Current Limit - 
Positive 

Positive Current Limit(P-TL) [Ft-0.11]-Digit2 

Current Limit - 
Negative 

Negative Current Limit(N-TL) [Ft-0.11]-Digit1 

Drive Enable Drive Enable(SV-ON) [Ft-0.10]-Digit0 

Fault Reset Fault Reset(A-RST) [Ft-0.11]-Digit0 

Integrator Inhibit Integrator Inhibit(P-CON) [Ft-0.10]-Digit3 

Operation Mode 
Override 

Operation Mode Override(C-SEL) [Ft-0.11]-Digit3 

Overtravel - 
Negative 

Negative Over-travel(N-OT) [Ft-0.10]-Digit2 

Overtravel - Positive Positive Over-travel(P-OT) [Ft-0.10]-Digit1 

Pause Follower Pause Follower(INHIBIT) [Ft-0.13]-Digit1 

Position Strobe Position Strobe(ABS-DT) [Ft-0.14]-Digit0 

Velocity Direction Preset Direction(C-DIR)  

Preset Select 1 Preset Select 1(C-SP1) [Ft-0.12]-Digit1 

Preset Select 2 Preset Select 2(C-SP2) [Ft-0.12]-Digit2 

Preset Select 3 Preset Select 3(C-SP3) [Ft-0.12]-Digit3 

Reset Multiturn Data Reset multi-turn data of  Absolute Encoder(R-ABS) [Ft-0.15]-Digit0 

Zero Speed Clamp 
Enable 

Zero Speed Clamp Enable(Z-CLP) [Ft-0.13]-Digit0 

Position Clear Position clear(PCLR) [Ft-0.13]-Digit3 

Moving Enable Motor Moving Enable (START). [Ft-0.14]-Digit1 

Analog Speed 
Command Enable 

Analog Speed Command Select (C-SP4) [Ft-0.14]-Digit2 

2nd Electronic Gear 
Bank Selection 

2nd Electronic Gear Bank Selection(GEAR) [Ft-0.14]-Digit3 

Home Sensor Home Sensor(H-SENS) [Ft-0.16]-Digit0 

Start Homing Start Homing(SHOME) [Ft-0.16]-Digit1 

Stop Indexing Stop Indexing(STOP) [Ft-0.16]-Digit2 

Pause Indexing Pause Indexing(PAUSE) [Ft-0.16]-Digit3 

Index Select0 Input Index Select 0 Input(I-SEL0) [Ft-0.17]-Digit0 

Index Select1 Input Index Select 1 Input(I-SEL1) [Ft-0.17]-Digit1 

Index Select2 Input Index Select 2 Input(I-SEL2) [Ft-0.17]-Digit2 

Index Select3 Input Index Select 3 Input(I-SEL3) [Ft-0.17]-Digit3 

Index Select4 Input Index Select 4 Input(I-SEL4) [Ft-0.18]-Digit0 

Index Select5 Input Index Select 5 Input(I-SEL5) [Ft-0.18]-Digit1 

Stop Homing Stop Homing(H-STOP)  [Ft-0.18]-Digit2 

Start Indexing Start Index(START-I) [Ft-0.18]-Digit3 

Current Limit-
Analog 

Analog Current Limit(A-CL) [Ft-0.15]-Digit1 
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Absolute Position 
Transfer Mode 

Absolute Position Transfer Mode(ABS-MD) 

 
Please refer to the above content. 

[Ft-0.15]-Digit2  

Current Limit-
Analog 

Analog Current Limit(A-CL) 
Note: This parameter is only added for CSD5 Drive 

[Ft-0.15]-Digit3 

Default: Index Select 0 Input 

Applicable 
Operating 
Mode: 

All 

  

When Enabled Servo-Off  -> Setting 

Description Select the drive's digital input assignments. 

Parameter [Ft-0.22]~ [Ft-0.27] 

Range: 

Select: Description Value 

Unassigned Unassigned [Ft-0.12]-Digit0 

Alternate Gain 
Select 

Alternate Gain Select(G-SEL) [Ft-0.13]-Digit2 

Current Limit - 
Positive 

Positive Current Limit(P-TL) [Ft-0.11]-Digit2 

Current Limit - 
Negative 

Negative Current Limit(N-TL) [Ft-0.11]-Digit1 

Drive Enable Drive Enable(SV-ON) [Ft-0.10]-Digit0 

Fault Reset Fault Reset(A-RST) [Ft-0.11]-Digit0 

Integrator Inhibit Integrator Inhibit(P-CON) [Ft-0.10]-Digit3 

Operation Mode 
Override 

Operation Mode Override(C-SEL) [Ft-0.11]-Digit3 

Overtravel - 
Negative 

Negative Over-travel(N-OT) [Ft-0.10]-Digit2 

Overtravel - Positive Positive Over-travel(P-OT) [Ft-0.10]-Digit1 

Pause Follower Pause Follower(INHIBIT) [Ft-0.13]-Digit1 

Position Strobe Position Strobe(ABS-DT) [Ft-0.14]-Digit0 

Velocity Direction Preset Direction(C-DIR)  

Preset Select 1 Preset Select 1(C-SP1) [Ft-0.12]-Digit1 

Preset Select 2 Preset Select 2(C-SP2) [Ft-0.12]-Digit2 

Preset Select 3 Preset Select 3(C-SP3) [Ft-0.12]-Digit3 

Reset Multiturn Data Reset multi-turn data of  Absolute Encoder(R-ABS) [Ft-0.15]-Digit0 

Zero Speed Clamp 
Enable 

Zero Speed Clamp Enable(Z-CLP) [Ft-0.13]-Digit0 

Position Clear Position clear(PCLR) [Ft-0.13]-Digit3 

Moving Enable Motor Moving Enable (START). [Ft-0.14]-Digit1 

Analog Speed 
Command Enable 

Analog Speed Command Select (C-SP4) [Ft-0.14]-Digit2 

2nd Electronic Gear 
Bank Selection 

2nd Electronic Gear Bank Selection(GEAR) [Ft-0.14]-Digit3 

Home Sensor Home Sensor(H-SENS) [Ft-0.16]-Digit0 

Start Homing Start Homing(SHOME) [Ft-0.16]-Digit1 

Stop Indexing Stop Indexing(STOP) [Ft-0.16]-Digit2 

Pause Indexing Pause Indexing(PAUSE) [Ft-0.16]-Digit3 

Index Select0 Input Index Select 0 Input(I-SEL0) [Ft-0.17]-Digit0 

Index Select1 Input Index Select 1 Input(I-SEL1) [Ft-0.17]-Digit1 

Index Select2 Input Index Select 2 Input(I-SEL2) [Ft-0.17]-Digit2 

Index Select3 Input Index Select 3 Input(I-SEL3) [Ft-0.17]-Digit3 
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Index Select4 Input Index Select 4 Input(I-SEL4) [Ft-0.18]-Digit0 

Index Select5 Input Index Select 5 Input(I-SEL5) [Ft-0.18]-Digit1 

Stop Homing Stop Homing(H-STOP)  [Ft-0.18]-Digit2 

Start Indexing Start Index(START-I) [Ft-0.18]-Digit3 

Current Limit-
Analog 

Analog Current Limit(A-CL) [Ft-0.15]-Digit1 

Absolute Position 
Transfer Mode 

Absolute Position Transfer Mode(ABS-MD) 

 
Please refer to the above content. 

[Ft-0.15]-Digit2  

Current Limit-
Analog 

Analog Current Limit(A-CL) 
Note: This parameter is only added for CSD5 Drive 

[Ft-0.15]-Digit3 

Default: Index Select 1 Input 

Applicable 
Operating 
Mode: 

All 

  

When Enabled Servo-Off  -> Setting 

Description Select the drive's digital input assignments. 

Parameter [Ft-0.22]~ [Ft-0.27] 

Range: 

Select: Description Value 

Unassigned Unassigned  

Alternate Gain 
Select 

Alternate Gain Select(G-SEL) [Ft-0.13]-Digit2 

Current Limit - 
Positive 

Positive Current Limit(P-TL) [Ft-0.11]-Digit2 

Current Limit - 
Negative 

Negative Current Limit(N-TL) [Ft-0.11]-Digit1 

Drive Enable Drive Enable(SV-ON) [Ft-0.10]-Digit0 

Fault Reset Fault Reset(A-RST) [Ft-0.11]-Digit0 

Integrator Inhibit Integrator Inhibit(P-CON) [Ft-0.10]-Digit3 

Operation Mode 
Override 

Operation Mode Override(C-SEL) [Ft-0.11]-Digit3 

Overtravel - 
Negative 

Negative Over-travel(N-OT) [Ft-0.10]-Digit2 

Overtravel - Positive Positive Over-travel(P-OT) [Ft-0.10]-Digit1 

Pause Follower Pause Follower(INHIBIT) [Ft-0.13]-Digit1 

Position Strobe Position Strobe(ABS-DT) [Ft-0.14]-Digit0 

Velocity Direction Preset Direction(C-DIR) [Ft-0.12]-Digit0 

Preset Select 1 Preset Select 1(C-SP1) [Ft-0.12]-Digit1 

Preset Select 2 Preset Select 2(C-SP2) [Ft-0.12]-Digit2 

Preset Select 3 Preset Select 3(C-SP3) [Ft-0.12]-Digit3 

Reset Multiturn Data Reset multi-turn data of  Absolute Encoder(R-ABS) [Ft-0.15]-Digit0 

Zero Speed Clamp 
Enable 

Zero Speed Clamp Enable(Z-CLP) [Ft-0.13]-Digit0 

Position Clear Position clear(PCLR) [Ft-0.13]-Digit3 

Moving Enable Motor Moving Enable (START). [Ft-0.14]-Digit1 

Analog Speed 
Command Enable 

Analog Speed Command Select (C-SP4) [Ft-0.14]-Digit2 

2nd Electronic Gear 
Bank Selection 

2nd Electronic Gear Bank Selection(GEAR) [Ft-0.14]-Digit3 

Home Sensor Home Sensor(H-SENS) [Ft-0.16]-Digit0 

Start Homing Start Homing(SHOME) [Ft-0.16]-Digit1 
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Stop Indexing Stop Indexing(STOP) [Ft-0.16]-Digit2 

Pause Indexing Pause Indexing(PAUSE) [Ft-0.16]-Digit3 

Index Select0 Input Index Select 0 Input(I-SEL0) [Ft-0.17]-Digit0 

Index Select1 Input Index Select 1 Input(I-SEL1) [Ft-0.17]-Digit1 

Index Select2 Input Index Select 2 Input(I-SEL2) [Ft-0.17]-Digit2 

Index Select3 Input Index Select 3 Input(I-SEL3) [Ft-0.17]-Digit3 

Index Select4 Input Index Select 4 Input(I-SEL4) [Ft-0.18]-Digit0 

Index Select5 Input Index Select 5 Input(I-SEL5) [Ft-0.18]-Digit1 

Stop Homing Stop Homing(H-STOP)  [Ft-0.18]-Digit2 

Start Indexing Start Index(START-I) [Ft-0.18]-Digit3 

Current Limit-
Analog 

Analog Current Limit(A-CL) [Ft-0.15]-Digit1 

Absolute Position 
Transfer Mode 

Absolute Position Transfer Mode(ABS-MD) 

 
Please refer to the above content. 

[Ft-0.15]-Digit2  

Current Limit-
Analog 

Analog Current Limit(A-CL) 
Note: This parameter is only added for CSD5 Drive 

[Ft-0.15]-Digit3 

Default: Start Indexing 

Applicable 
Operating 
Mode: 

All 

  

When Enabled Servo-Off  -> Setting 

Description Select the drive's digital input assignments. 

Parameter [Ft-0.22]~ [Ft-0.27] 

Range: 

Select: Description Value 

Unassigned Unassigned  

Alternate Gain 
Select 

Alternate Gain Select(G-SEL) [Ft-0.13]-Digit2 

Current Limit - 
Positive 

Positive Current Limit(P-TL) [Ft-0.11]-Digit2 

Current Limit - 
Negative 

Negative Current Limit(N-TL) [Ft-0.11]-Digit1 

Drive Enable Drive Enable(SV-ON) [Ft-0.10]-Digit0 

Fault Reset Fault Reset(A-RST) [Ft-0.11]-Digit0 

Integrator Inhibit Integrator Inhibit(P-CON) [Ft-0.10]-Digit3 

Operation Mode 
Override 

Operation Mode Override(C-SEL) [Ft-0.11]-Digit3 

Overtravel - 
Negative 

Negative Over-travel(N-OT) [Ft-0.10]-Digit2 

Overtravel - Positive Positive Over-travel(P-OT) [Ft-0.10]-Digit1 

Pause Follower Pause Follower(INHIBIT) [Ft-0.13]-Digit1 

Position Strobe Position Strobe(ABS-DT) [Ft-0.14]-Digit0 

Velocity Direction Preset Direction(C-DIR) [Ft-0.12]-Digit0 

Preset Select 1 Preset Select 1(C-SP1) [Ft-0.12]-Digit1 

Preset Select 2 Preset Select 2(C-SP2) [Ft-0.12]-Digit2 

Preset Select 3 Preset Select 3(C-SP3) [Ft-0.12]-Digit3 

Reset Multiturn Data Reset multi-turn data of  Absolute Encoder(R-ABS) [Ft-0.15]-Digit0 

Zero Speed Clamp 
Enable 

Zero Speed Clamp Enable(Z-CLP) [Ft-0.13]-Digit0 

Position Clear Position clear(PCLR) [Ft-0.13]-Digit3 

Moving Enable Motor Moving Enable (START). [Ft-0.14]-Digit1 



RSWare User Manual   

Analog Speed 
Command Enable 

Analog Speed Command Select (C-SP4) [Ft-0.14]-Digit2 

2nd Electronic Gear 
Bank Selection 

2nd Electronic Gear Bank Selection(GEAR) [Ft-0.14]-Digit3 

Home Sensor Home Sensor(H-SENS) [Ft-0.16]-Digit0 

Start Homing Start Homing(SHOME) [Ft-0.16]-Digit1 

Stop Indexing Stop Indexing(STOP) [Ft-0.16]-Digit2 

Pause Indexing Pause Indexing(PAUSE) [Ft-0.16]-Digit3 

Index Select0 Input Index Select 0 Input(I-SEL0) [Ft-0.17]-Digit0 

Index Select1 Input Index Select 1 Input(I-SEL1) [Ft-0.17]-Digit1 

Index Select2 Input Index Select 2 Input(I-SEL2) [Ft-0.17]-Digit2 

Index Select3 Input Index Select 3 Input(I-SEL3) [Ft-0.17]-Digit3 

Index Select4 Input Index Select 4 Input(I-SEL4) [Ft-0.18]-Digit0 

Index Select5 Input Index Select 5 Input(I-SEL5) [Ft-0.18]-Digit1 

Stop Homing Stop Homing(H-STOP)  [Ft-0.18]-Digit2 

Start Indexing Start Index(START-I) [Ft-0.18]-Digit3 

Current Limit-
Analog 

Analog Current Limit(A-CL) [Ft-0.15]-Digit1 

Absolute Position 
Transfer Mode 

Absolute Position Transfer Mode(ABS-MD) 

 
Please refer to the above content. 

[Ft-0.15]-Digit2  

Current Limit-
Analog 

Analog Current Limit(A-CL) 
Note: This parameter is only added for CSD5 Drive 

[Ft-0.15]-Digit3 

Default: Index Select 2 Input 

Applicable 
Operating 
Mode: 

All 

  

When Enabled Servo-Off  -> Setting 

Description Select the drive's digital input assignments. 

Parameter [Ft-0.22]~ [Ft-0.27] 

Range: 

Select: Description Value 

Unassigned Unassigned  

Alternate Gain 
Select 

Alternate Gain Select(G-SEL) [Ft-0.13]-Digit2 

Current Limit - 
Positive 

Positive Current Limit(P-TL) [Ft-0.11]-Digit2 

Current Limit - 
Negative 

Negative Current Limit(N-TL) [Ft-0.11]-Digit1 

Drive Enable Drive Enable(SV-ON) [Ft-0.10]-Digit0 

Fault Reset Fault Reset(A-RST) [Ft-0.11]-Digit0 

Integrator Inhibit Integrator Inhibit(P-CON) [Ft-0.10]-Digit3 

Operation Mode 
Override 

Operation Mode Override(C-SEL) [Ft-0.11]-Digit3 

Overtravel - 
Negative 

Negative Over-travel(N-OT) [Ft-0.10]-Digit2 

Overtravel - Positive Positive Over-travel(P-OT) [Ft-0.10]-Digit1 

Pause Follower Pause Follower(INHIBIT) [Ft-0.13]-Digit1 

Position Strobe Position Strobe(ABS-DT) [Ft-0.14]-Digit0 

Velocity Direction Preset Direction(C-DIR) [Ft-0.12]-Digit0 

Preset Select 1 Preset Select 1(C-SP1) [Ft-0.12]-Digit1 

Preset Select 2 Preset Select 2(C-SP2) [Ft-0.12]-Digit2 
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Preset Select 3 Preset Select 3(C-SP3) [Ft-0.12]-Digit3 

Reset Multiturn Data Reset multi-turn data of  Absolute Encoder(R-ABS) [Ft-0.15]-Digit0 

Zero Speed Clamp 
Enable 

Zero Speed Clamp Enable(Z-CLP) [Ft-0.13]-Digit0 

Position Clear Position clear(PCLR) [Ft-0.13]-Digit3 

Moving Enable Motor Moving Enable (START). [Ft-0.14]-Digit1 

Analog Speed 
Command Enable 

Analog Speed Command Select (C-SP4) [Ft-0.14]-Digit2 

2nd Electronic Gear 
Bank Selection 

2nd Electronic Gear Bank Selection(GEAR) [Ft-0.14]-Digit3 

Home Sensor Home Sensor(H-SENS) [Ft-0.16]-Digit0 

Start Homing Start Homing(SHOME) [Ft-0.16]-Digit1 

Stop Indexing Stop Indexing(STOP) [Ft-0.16]-Digit2 

Pause Indexing Pause Indexing(PAUSE) [Ft-0.16]-Digit3 

Index Select0 Input Index Select 0 Input(I-SEL0) [Ft-0.17]-Digit0 

Index Select1 Input Index Select 1 Input(I-SEL1) [Ft-0.17]-Digit1 

Index Select2 Input Index Select 2 Input(I-SEL2) [Ft-0.17]-Digit2 

Index Select3 Input Index Select 3 Input(I-SEL3) [Ft-0.17]-Digit3 

Index Select4 Input Index Select 4 Input(I-SEL4) [Ft-0.18]-Digit0 

Index Select5 Input Index Select 5 Input(I-SEL5) [Ft-0.18]-Digit1 

Stop Homing Stop Homing(H-STOP)  [Ft-0.18]-Digit2 

Start Indexing Start Index(START-I) [Ft-0.18]-Digit3 

Current Limit-
Analog 

Analog Current Limit(A-CL) [Ft-0.15]-Digit1 

Absolute Position 
Transfer Mode 

Absolute Position Transfer Mode(ABS-MD) 

 
Please refer to the above content. 

[Ft-0.15]-Digit2  

Current Limit-
Analog 

Analog Current Limit(A-CL) 
Note: This parameter is only added for CSD5 Drive 

[Ft-0.15]-Digit3 

Default: Unassigned 

Applicable 
Operating 
Mode: 

All 

  

When Enabled Servo-Off  -> Setting 

Description Select the drive's digital input assignments. 

Parameter [Ft-0.22]~ [Ft-0.27] 

Range: 

Select: Description Value 

Unassigned Unassigned  

Alternate Gain 
Select 

Alternate Gain Select(G-SEL) [Ft-0.13]-Digit2 

Current Limit - 
Positive 

Positive Current Limit(P-TL) [Ft-0.11]-Digit2 

Current Limit - 
Negative 

Negative Current Limit(N-TL) [Ft-0.11]-Digit1 

Drive Enable Drive Enable(SV-ON) [Ft-0.10]-Digit0 

Fault Reset Fault Reset(A-RST) [Ft-0.11]-Digit0 

Integrator Inhibit Integrator Inhibit(P-CON) [Ft-0.10]-Digit3 

Operation Mode 
Override 

Operation Mode Override(C-SEL) [Ft-0.11]-Digit3 

Overtravel - 
Negative 

Negative Over-travel(N-OT) [Ft-0.10]-Digit2 
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Overtravel - Positive Positive Over-travel(P-OT) [Ft-0.10]-Digit1 

Pause Follower Pause Follower(INHIBIT) [Ft-0.13]-Digit1 

Position Strobe Position Strobe(ABS-DT) [Ft-0.14]-Digit0 

Velocity Direction Preset Direction(C-DIR) [Ft-0.12]-Digit0 

Preset Select 1 Preset Select 1(C-SP1) [Ft-0.12]-Digit1 

Preset Select 2 Preset Select 2(C-SP2) [Ft-0.12]-Digit2 

Preset Select 3 Preset Select 3(C-SP3) [Ft-0.12]-Digit3 

Reset Multiturn Data Reset multi-turn data of  Absolute Encoder(R-ABS) [Ft-0.15]-Digit0 

Zero Speed Clamp 
Enable 

Zero Speed Clamp Enable(Z-CLP) [Ft-0.13]-Digit0 

Position Clear Position clear(PCLR) [Ft-0.13]-Digit3 

Moving Enable Motor Moving Enable (START). [Ft-0.14]-Digit1 

Analog Speed 
Command Enable 

Analog Speed Command Select (C-SP4) [Ft-0.14]-Digit2 

2nd Electronic Gear 
Bank Selection 

2nd Electronic Gear Bank Selection(GEAR) [Ft-0.14]-Digit3 

Home Sensor Home Sensor(H-SENS) [Ft-0.16]-Digit0 

Start Homing Start Homing(SHOME) [Ft-0.16]-Digit1 

Stop Indexing Stop Indexing(STOP) [Ft-0.16]-Digit2 

Pause Indexing Pause Indexing(PAUSE) [Ft-0.16]-Digit3 

Index Select0 Input Index Select 0 Input(I-SEL0) [Ft-0.17]-Digit0 

Index Select1 Input Index Select 1 Input(I-SEL1) [Ft-0.17]-Digit1 

Index Select2 Input Index Select 2 Input(I-SEL2) [Ft-0.17]-Digit2 

Index Select3 Input Index Select 3 Input(I-SEL3) [Ft-0.17]-Digit3 

Index Select4 Input Index Select 4 Input(I-SEL4) [Ft-0.18]-Digit0 

Index Select5 Input Index Select 5 Input(I-SEL5) [Ft-0.18]-Digit1 

Stop Homing Stop Homing(H-STOP)  [Ft-0.18]-Digit2 

Start Indexing Start Index(START-I) [Ft-0.18]-Digit3 

Current Limit-
Analog 

Analog Current Limit(A-CL) [Ft-0.15]-Digit1 

Absolute Position 
Transfer Mode 

Absolute Position Transfer Mode(ABS-MD) 

 
Please refer to the above content. 

[Ft-0.15]-Digit2  

Current Limit-
Analog 

Analog Current Limit(A-CL) 
Note: This parameter is only added for CSD5 Drive 

[Ft-0.15]-Digit3 

Default: Unassigned 

Applicable 
Operating 
Mode: 

All 

  

When Enabled Servo-Off  -> Setting 

Description Select the drive's digital input assignments. 

Parameter [Ft-0.22]~ [Ft-0.27] 

Range: 

Select: Description Value 

Unassigned Unassigned  

Alternate Gain 
Select 

Alternate Gain Select(G-SEL) [Ft-0.13]-Digit2 

Current Limit - 
Positive 

Positive Current Limit(P-TL) [Ft-0.11]-Digit2 

Current Limit - 
Negative 

Negative Current Limit(N-TL) [Ft-0.11]-Digit1 

Drive Enable Drive Enable(SV-ON) [Ft-0.10]-Digit0 
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Fault Reset Fault Reset(A-RST) [Ft-0.11]-Digit0 

Integrator Inhibit Integrator Inhibit(P-CON) [Ft-0.10]-Digit3 

Operation Mode 
Override 

Operation Mode Override(C-SEL) [Ft-0.11]-Digit3 

Overtravel - 
Negative 

Negative Over-travel(N-OT) [Ft-0.10]-Digit2 

Overtravel - Positive Positive Over-travel(P-OT) [Ft-0.10]-Digit1 

Pause Follower Pause Follower(INHIBIT) [Ft-0.13]-Digit1 

Position Strobe Position Strobe(ABS-DT) [Ft-0.14]-Digit0 

Velocity Direction Preset Direction(C-DIR) [Ft-0.12]-Digit0 

Preset Select 1 Preset Select 1(C-SP1) [Ft-0.12]-Digit1 

Preset Select 2 Preset Select 2(C-SP2) [Ft-0.12]-Digit2 

Preset Select 3 Preset Select 3(C-SP3) [Ft-0.12]-Digit3 

Reset Multiturn Data Reset multi-turn data of  Absolute Encoder(R-ABS) [Ft-0.15]-Digit0 

Zero Speed Clamp 
Enable 

Zero Speed Clamp Enable(Z-CLP) [Ft-0.13]-Digit0 

Position Clear Position clear(PCLR) [Ft-0.13]-Digit3 

Moving Enable Motor Moving Enable (START). [Ft-0.14]-Digit1 

Analog Speed 
Command Enable 

Analog Speed Command Select (C-SP4) [Ft-0.14]-Digit2 

2nd Electronic Gear 
Bank Selection 

2nd Electronic Gear Bank Selection(GEAR) [Ft-0.14]-Digit3 

Home Sensor Home Sensor(H-SENS) [Ft-0.16]-Digit0 

Start Homing Start Homing(SHOME) [Ft-0.16]-Digit1 

Stop Indexing Stop Indexing(STOP) [Ft-0.16]-Digit2 

Pause Indexing Pause Indexing(PAUSE) [Ft-0.16]-Digit3 

Index Select0 Input Index Select 0 Input(I-SEL0) [Ft-0.17]-Digit0 

Index Select1 Input Index Select 1 Input(I-SEL1) [Ft-0.17]-Digit1 

Index Select2 Input Index Select 2 Input(I-SEL2) [Ft-0.17]-Digit2 

Index Select3 Input Index Select 3 Input(I-SEL3) [Ft-0.17]-Digit3 

Index Select4 Input Index Select 4 Input(I-SEL4) [Ft-0.18]-Digit0 

Index Select5 Input Index Select 5 Input(I-SEL5) [Ft-0.18]-Digit1 

Stop Homing Stop Homing(H-STOP)  [Ft-0.18]-Digit2 

Start Indexing Start Index(START-I) [Ft-0.18]-Digit3 

Current Limit-
Analog 

Analog Current Limit(A-CL) [Ft-0.15]-Digit1 

Absolute Position 
Transfer Mode 

Absolute Position Transfer Mode(ABS-MD) 

 
Please refer to the above content. 

[Ft-0.15]-Digit2  

Current Limit-
Analog 

Analog Current Limit(A-CL) 
Note: This parameter is only added for CSD5 Drive 

[Ft-0.15]-Digit3 

Default: Unassigned 

Applicable 
Operating 
Mode: 

All 

  

When Enabled Servo-Off  -> Setting 

 
The following statuses are displayed by default for a CSD5 drive in the Digital 
Inputs window: 
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Input 1~10 State 

The current state, or condition, of each digital input is 
depicted by a light bulb icon, as follows: 
ON- a bright light bulb 
OFF- a darkened light bulb. 

 
No Special commands are associated with the Digital Inputs window. 
 
Customize the Digital Inputs window for your CSD5 Drive branch by selecting 
one or more of the following buttons: 

• Toggle the Show Status selection to display or hide the Status pane. 

• Toggle the Show Commands selection to display or hide the 
Commands pane. 

• Click on the Revert button to return parameter settings to the values 
they held when you opened this window. 

The Properties window for Digital Outputs looks like this 

 
 
Use the Digital Outputs window to: 

• assign functionality to digital outputs, 

• set both active and inactive brake delays, 

• monitor the status of digital outputs.  

The following parameters are associated with this window: 
 

Description Select the functionality to be assigned to digital output 1 

Parameter [Ft-0.22]~ [Ft-0.27] 
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Range: 

Select: Description Value 

Unassigned Unassigned  

Within position 
window 

Within position window (P-COM): An active 
output state indicates that the position error has 
been less than the Position Functions: In Position 
Size setting for longer than the Position Functions: 
In Position Time setting in the CSD5 Drive 
window. 

[Ft-0.22]-Digit0 

Up to speed 
Up to speed (TG-ON): An active output state 
indicates motor velocity feedback is greater than the 
Up to Speed setting in the CSD5 Drive window. 

[Ft-0.22]-Digit1 

Brake  

Brake control (BK): Used to control a motor brake. 
An active state releases the motor brake. The Brake 
signal is the same as the Drive Enabled signal, with 
the addition of  the turn-on and turn-off  delays 
specified by the Brake Active Delay and Brake 
Inactive Delay. 

[Ft-0.22]-Digit2 

Within Speed 
window 

Within Speed window (V-COM): An active output 
state indicates that the velocity error is less than the 
In Speed Window setting in the CSD5 drive 
window. 

[Ft-0.22]-Digit3 

Current Limited 
Current Limited (T-LMT): An active state indicates 
the drive's current is being limited as set in the 
Drive window. 

[Ft-0.23]-Digit0 

Velocity Limited 
Velocity Limited (V-LMT) ): An active state 
indicates the drive's velocity is being limited as set in 
the Drive window. 

[Ft-0.23]-Digit1 

With Near Window Near position(NEAR) [Ft-0.23]-Digit2 

Warning Warning(WARN) [Ft-0.23]-Digit3 

Absolute position 
valid  

Absolute position valid(A-VLD) [Ft-0.24]-Digit0 

Ready 
Servo drive ready: An active state indicates the drive 
is operational and does not have a fault. 

[Ft-0.24]-Digit1 

In Motion 
In Motion (IMO): An active state indicates an index 
move is active and the motor is moving. 

[Ft-0.25]-Digit0 

I Dwell 
In Dwell (I-DW): An active state indicates the 
motor is holding position in an index move and 
waiting for the commanded dwell time. 

[Ft-0.25]-Digit1 

Axis Homed 
Axis Homed (HOMC): An active state indicates 
that the homing routine has completed. 

[Ft-0.25]-Digit2 

Index Select 0 
Output 

Index Select 0 Out(O-ISEL0) [Ft-0.25]-Digit3 

Index Select 1 
Output 

Index Select 1 Out(O-ISEL1) [Ft-0.26]-Digit0 

Index Select 2 
Output 

Index Select 2 Out(O-ISEL2) [Ft-0.26]-Digit1 

Index Select 3 
Output 

Index Select 3 Out(O-ISEL3) [Ft-0.26]-Digit2 

Index Select 4 
Output 

Index Select 4 Out(O-ISEL4) [Ft-0.26]-Digit3 

Index Select 5 
Output Moving 
Enable 

Index Select 5 Out(O-ISEL5) [Ft-0.27]-Digit0 

End of  Sequence  

End of  Sequence (E-SEQU): An active state 
indicates all iterations of  the index move have been 
completed. 
Note: This parameter is only added for CSD5 
Drive. 

[Ft-0.27]-Digit1 

Default: Within Position Window 
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Applicable 
Operating 
Mode: 

All 

  

When Enabled Servo-Off  -> Setting- 

Description Select the functionality to be assigned to digital output 2 

Parameter [Ft-0.22]~ [Ft-0.27] 

Range: 

Select: Description Value 

Unassigned Unassigned  

Within position 
window 

Within position window (P-COM): An active 
output state indicates that the position error has 
been less than the Position Functions: In Position 
Size setting for longer than the Position Functions: 
In Position Time setting in the CSD5 Drive 
window. 

[Ft-0.22]-Digit0 

Up to speed 
Up to speed (TG-ON): An active output state 
indicates motor velocity feedback is greater than the 
Up to Speed setting in the CSD5 Drive window. 

[Ft-0.22]-Digit1 

Brake  

Brake control (BK): Used to control a motor brake. 
An active state releases the motor brake. The Brake 
signal is the same as the Drive Enabled signal, with 
the addition of  the turn-on and turn-off  delays 
specified by the Brake Active Delay and Brake 
Inactive Delay. 

[Ft-0.22]-Digit2 

Within Speed 
window 

Within Speed window(V-COM): An active output 
state indicates that the velocity error is less than the 
In Speed Window setting in the CSD5 drive 
window. 

[Ft-0.22]-Digit3 

Current Limited 
Current Limited (T-LMT): An active state indicates 
the drive's current is being limited as set in the 
Drive window. 

[Ft-0.23]-Digit0 

Velocity Limited 
Velocity Limited (V-LMT) ): An active state 
indicates the drive's velocity is being limited as set in 
the Drive window. 

[Ft-0.23]-Digit1 

With Near Window Near position(NEAR) [Ft-0.23]-Digit2 

Warning Warning(WARN) [Ft-0.23]-Digit3 

Absolute position 
valid  

Absolute position valid(A-VLD) [Ft-0.24]-Digit0 

Ready 
Servo drive ready: An active state indicates the drive 
is operational and does not have a fault. 

[Ft-0.24]-Digit1 

In Motion 
In Motion (IMO): An active state indicates an index 
move is active and the motor is moving. 

[Ft-0.25]-Digit0 

I Dwell 
In Dwell (I-DW): An active state indicates the 
motor is holding position in an index move and 
waiting for the commanded dwell time. 

[Ft-0.25]-Digit1 

Axis Homed 
Axis Homed (HOMC): An active state indicates 
that the homing routine has completed. 

[Ft-0.25]-Digit2 

Index Select 0 
Output 

Index Select 0 Out(O-ISEL0) [Ft-0.25]-Digit3 

Index Select 1 
Output 

Index Select 1 Out(O-ISEL1) [Ft-0.26]-Digit0 

Index Select 2 
Output 

Index Select 2 Out(O-ISEL2) [Ft-0.26]-Digit1 

Index Select 3 
Output 

Index Select 3 Out(O-ISEL3) [Ft-0.26]-Digit2 

Index Select 4 
Output 

Index Select 4 Out(O-ISEL4) [Ft-0.26]-Digit3 
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Index Select 5 
Output Moving 
Enable 

Index Select 5 Out(O-ISEL5) [Ft-0.27]-Digit0 

End of  Sequence  

End of  Sequence (E-SEQU): An active state 
indicates all iterations of  the index move have been 
completed. 
Note: This parameter is only added for CSD5 
Drive. 

[Ft-0.27]-Digit1 

Default: Up to speed 

Applicable 
Operating 
Mode: 

All 

  

When Enabled Servo-Off  -> Setting- 

Description Select the functionality to be assigned to digital output 3 

Parameter [Ft-0.22]~ [Ft-0.27] 

Range: 

Select: Description Value 

Unassigned Unassigned  

Within position 
window 

Within position window (P-COM): An active 
output state indicates that the position error has 
been less than the Position Functions: In Position 
Size setting for longer than the Position Functions: 
In Position Time setting in the CSD5 Drive 
window. 

[Ft-0.22]-Digit0 

Up to speed 
Up to speed (TG-ON): An active output state 
indicates motor velocity feedback is greater than the 
Up to Speed setting in the CSD5 Drive window. 

[Ft-0.22]-Digit1 

Brake  

Brake control (BK): Used to control a motor brake. 
An active state releases the motor brake. The Brake 
signal is the same as the Drive Enabled signal, with 
the addition of  the turn-on and turn-off  delays 
specified by the Brake Active Delay and Brake 
Inactive Delay. 

[Ft-0.22]-Digit2 

Within Speed 
window 

Within Speed window (V-COM): An active output 
state indicates that the velocity error is less than the 
In Speed Window setting in the CSD5 drive 
window. 

[Ft-0.22]-Digit3 

Current Limited 
Current Limited (T-LMT): An active state indicates 
the drive's current is being limited as set in the 
Drive window. 

[Ft-0.23]-Digit0 

Velocity Limited 
Velocity Limited (V-LMT) ): An active state 
indicates the drive's velocity is being limited as set in 
the Drive window. 

[Ft-0.23]-Digit1 

With Near Window Near position(NEAR) [Ft-0.23]-Digit2 

Warning Warning(WARN) [Ft-0.23]-Digit3 

Absolute position 
valid  

Absolute position valid(A-VLD) [Ft-0.24]-Digit0 

Ready 
Servo drive ready: An active state indicates the drive 
is operational and does not have a fault. 

[Ft-0.24]-Digit1 

In Motion 
In Motion (IMO): An active state indicates an index 
move is active and the motor is moving. 

[Ft-0.25]-Digit0 

I Dwell 
In Dwell (I-DW): An active state indicates the 
motor is holding position in an index move and 
waiting for the commanded dwell time. 

[Ft-0.25]-Digit1 

Axis Homed 
Axis Homed (HOMC): An active state indicates 
that the homing routine has completed. 

[Ft-0.25]-Digit2 

Index Select 0 
Output 

Index Select 0 Out(O-ISEL0) [Ft-0.25]-Digit3 
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Index Select 1 
Output 

Index Select 1 Out(O-ISEL1) [Ft-0.26]-Digit0 

Index Select 2 
Output 

Index Select 2 Out(O-ISEL2) [Ft-0.26]-Digit1 

Index Select 3 
Output 

Index Select 3 Out(O-ISEL3) [Ft-0.26]-Digit2 

Index Select 4 
Output 

Index Select 4 Out(O-ISEL4) [Ft-0.26]-Digit3 

Index Select 5 
Output Moving 
Enable 

Index Select 5 Out(O-ISEL5) [Ft-0.27]-Digit0 

End of  Sequence  

End of  Sequence (E-SEQU): An active state 
indicates all iterations of  the index move have been 
completed. 
Note: This parameter is only added for CSD5 
Drive. 

[Ft-0.27]-Digit1 

Default: Brake 

Applicable 
Operating 
Mode: 

All 

  

When Enabled Servo-Off  -> Setting- 

Description Select the functionality to be assigned to digital output 4 

Parameter [Ft-0.22]~ [Ft-0.27] 

Range: 

Select: Description Value 

Unassigned Unassigned  

Within position 
window 

Within position window (P-COM): An active 
output state indicates that the position error has 
been less than the Position Functions: In Position 
Size setting for longer than the Position Functions: 
In Position Time setting in the CSD5 Drive 
window. 

[Ft-0.22]-Digit0 

Up to speed 
Up to speed (TG-ON): An active output state 
indicates motor velocity feedback is greater than the 
Up to Speed setting in the CSD5 Drive window. 

[Ft-0.22]-Digit1 

Brake  

Brake control (BK): Used to control a motor brake. 
An active state releases the motor brake. The Brake 
signal is the same as the Drive Enabled signal, with 
the addition of  the turn-on and turn-off  delays 
specified by the Brake Active Delay and Brake 
Inactive Delay. 

[Ft-0.22]-Digit2 

Within Speed 
window 

Within Speed window (V-COM): An active output 
state indicates that the velocity error is less than the 
In Speed Window setting in the CSD5 drive 
window. 

[Ft-0.22]-Digit3 

Current Limited 
Current Limited (T-LMT): An active state indicates 
the drive's current is being limited as set in the 
Drive window. 

[Ft-0.23]-Digit0 

Velocity Limited 
Velocity Limited (V-LMT): An active state indicates 
the drive's velocity is being limited as set in the 
Drive window. 

[Ft-0.23]-Digit1 

With Near Window Near position(NEAR) [Ft-0.23]-Digit2 

Warning Warning(WARN) [Ft-0.23]-Digit3 

Absolute position 
valid  

Absolute position valid(A-VLD) [Ft-0.24]-Digit0 

Ready 
Servo drive ready: An active state indicates the drive 
is operational and does not have a fault. 

[Ft-0.24]-Digit1 
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In Motion 
In Motion (IMO): An active state indicates an index 
move is active and the motor is moving. 

[Ft-0.25]-Digit0 

I Dwell 
In Dwell (I-DW): An active state indicates the 
motor is holding position in an index move and 
waiting for the commanded dwell time. 

[Ft-0.25]-Digit1 

Axis Homed 
Axis Homed (HOMC): An active state indicates 
that the homing routine has completed. 

[Ft-0.25]-Digit2 

Index Select 0 
Output 

Index Select 0 Out(O-ISEL0) [Ft-0.25]-Digit3 

Index Select 1 
Output 

Index Select 1 Out(O-ISEL1) [Ft-0.26]-Digit0 

Index Select 2 
Output 

Index Select 2 Out(O-ISEL2) [Ft-0.26]-Digit1 

Index Select 3 
Output 

Index Select 3 Out(O-ISEL3) [Ft-0.26]-Digit2 

Index Select 4 
Output 

Index Select 4 Out(O-ISEL4) [Ft-0.26]-Digit3 

Index Select 5 
Output Moving 
Enable 

Index Select 5 Out(O-ISEL5) [Ft-0.27]-Digit0 

End of  Sequence  

End of  Sequence (E-SEQU): An active state 
indicates all iterations of  the index move have been 
completed. 
Note: This parameter is only added for CSD5 
Drive. 

[Ft-0.27]-Digit1 

Default: Unassigned 

Applicable 
Operating 
Mode: 

All 

  

When Enabled Servo-Off  -> Setting- 

Description Select the functionality to be assigned to digital output 5 

Parameter [Ft-0.22]~ [Ft-0.27] 

Range: 

Select: Description Value 

Unassigned Unassigned  

Within position 
window 

Within position window (P-COM): An active 
output state indicates that the position error has 
been less than the Position Functions: In Position 
Size setting for longer than the Position Functions: 
In Position Time setting in the CSD5 Drive 
window. 

[Ft-0.22]-Digit0 

Up to speed 
Up to speed (TG-ON): An active output state 
indicates motor velocity feedback is greater than the 
Up to Speed setting in the CSD5 Drive window. 

[Ft-0.22]-Digit1 

Brake  

Brake control (BK): Used to control a motor brake. 
An active state releases the motor brake. The Brake 
signal is the same as the Drive Enabled signal, with 
the addition of  the turn-on and turn-off  delays 
specified by the Brake Active Delay and Brake 
Inactive Delay. 

[Ft-0.22]-Digit2 

Within Speed 
window 

Within Speed window (V-COM): An active output 
state indicates that the velocity error is less than the 
In Speed Window setting in the CSD5 drive 
window. 

[Ft-0.22]-Digit3 

Current Limited 
Current Limited (T-LMT): An active state indicates 
the drive's current is being limited as set in the 
Drive window. 

[Ft-0.23]-Digit0 
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Velocity Limited 
Velocity Limited (V-LMT) ): An active state 
indicates the drive's velocity is being limited as set in 
the Drive window. 

[Ft-0.23]-Digit1 

With Near Window Near position(NEAR) [Ft-0.23]-Digit2 

Warning Warning(WARN) [Ft-0.23]-Digit3 

Absolute position 
valid  

Absolute position valid(A-VLD) [Ft-0.24]-Digit0 

Ready 
Servo drive ready: An active state indicates the drive 
is operational and does not have a fault. 

[Ft-0.24]-Digit1 

In Motion 
In Motion (IMO): An active state indicates an index 
move is active and the motor is moving. 

[Ft-0.25]-Digit0 

I Dwell 
In Dwell (I-DW): An active state indicates the 
motor is holding position in an index move and 
waiting for the commanded dwell time. 

[Ft-0.25]-Digit1 

Axis Homed 
Axis Homed (HOMC): An active state indicates 
that the homing routine has completed. 

[Ft-0.25]-Digit2 

Index Select 0 
Output 

Index Select 0 Out(O-ISEL0) [Ft-0.25]-Digit3 

Index Select 1 
Output 

Index Select 1 Out(O-ISEL1) [Ft-0.26]-Digit0 

Index Select 2 
Output 

Index Select 2 Out(O-ISEL2) [Ft-0.26]-Digit1 

Index Select 3 
Output 

Index Select 3 Out(O-ISEL3) [Ft-0.26]-Digit2 

Index Select 4 
Output 

Index Select 4 Out(O-ISEL4) [Ft-0.26]-Digit3 

Index Select 5 
Output Moving 
Enable 

Index Select 5 Out(O-ISEL5) [Ft-0.27]-Digit0 

End of  Sequence  

End of  Sequence (E-SEQU): An active state 
indicates all iterations of  the index move have been 
completed. 
Note: This parameter is only added for CSD5 
Drive. 

[Ft-0.27]-Digit1 

Default: Unassigned 

Applicable 
Operating 
Mode: 

All 

  

When Enabled Servo-Off  -> Setting- 

Description Select the functionality to be assigned to digital output 6 

Parameter [Ft-0.22]~ [Ft-0.27] 

Range: 

Select: Description Value 

Unassigned Unassigned  

Within position 
window 

Within position window (P-COM): An active 
output state indicates that the position error has 
been less than the Position Functions: In Position 
Size setting for longer than the Position Functions: 
In Position Time setting in the CSD5 Drive 
window. 

[Ft-0.22]-Digit0 

Up to speed 
Up to speed (TG-ON): An active output state 
indicates motor velocity feedback is greater than the 
Up to Speed setting in the CSD5 Drive window. 

[Ft-0.22]-Digit1 
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Brake  

Brake control (BK): Used to control a motor brake. 
An active state releases the motor brake. The Brake 
signal is the same as the Drive Enabled signal, with 
the addition of  the turn-on and turn-off  delays 
specified by the Brake Active Delay and Brake 
Inactive Delay. 

[Ft-0.22]-Digit2 

Within Speed 
window 

Within Speed window (V-COM): An active output 
state indicates that the velocity error is less than the 
In Speed Window setting in the CSD5 drive 
window. 

[Ft-0.22]-Digit3 

Current Limited 
Current Limited (T-LMT): An active state indicates 
the drive's current is being limited as set in the 
Drive window. 

[Ft-0.23]-Digit0 

Velocity Limited 
Velocity Limited (V-LMT): An active state indicates 
the drive's velocity is being limited as set in the 
Drive window. 

[Ft-0.23]-Digit1 

With Near Window Near position(NEAR) [Ft-0.23]-Digit2 

Warning Warning(WARN) [Ft-0.23]-Digit3 

Absolute position 
valid  

Absolute position valid(A-VLD) [Ft-0.24]-Digit0 

Ready 
Servo drive ready: An active state indicates the drive 
is operational and does not have a fault. 

[Ft-0.24]-Digit1 

In Motion 
In Motion (IMO): An active state indicates an index 
move is active and the motor is moving. 

[Ft-0.25]-Digit0 

I Dwell 
In Dwell (I-DW): An active state indicates the 
motor is holding position in an index move and 
waiting for the commanded dwell time. 

[Ft-0.25]-Digit1 

Axis Homed 
Axis Homed (HOMC): An active state indicates 
that the homing routine has completed. 

[Ft-0.25]-Digit2 

Index Select 0 
Output 

Index Select 0 Out(O-ISEL0) [Ft-0.25]-Digit3 

Index Select 1 
Output 

Index Select 1 Out(O-ISEL1) [Ft-0.26]-Digit0 

Index Select 2 
Output 

Index Select 2 Out(O-ISEL2) [Ft-0.26]-Digit1 

Index Select 3 
Output 

Index Select 3 Out(O-ISEL3) [Ft-0.26]-Digit2 

Index Select 4 
Output 

Index Select 4 Out(O-ISEL4) [Ft-0.26]-Digit3 

Index Select 5 
Output Moving 
Enable 

Index Select 5 Out(O-ISEL5) [Ft-0.27]-Digit0 

End of  Sequence  

End of  Sequence (E-SEQU): An active state 
indicates all iterations of  the index move have been 
completed. 
Note: This parameter is only added for CSD5 
Drive. 

[Ft-0.27]-Digit1 

Default: Unassigned 

Applicable 
Operating 
Mode: 

All 

  

When Enabled Servo-Off  -> Setting 

Description The time delay between disabling the drive and deactivating the Brake output, which applies the motor brake. 

Parameter [Ft-5.06] 

Range: 0~10000 

Default: 0 
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Units: ms 

Applicable 
Operating 
Mode: 

All 

When Enabled Servo-Off  -> Setting 

Description The time delay between enabling the drive and activating the Brake output, which releases the motor brake. 

Parameter [Ft-5.08] 

Range: 0~10000 

Default: 500 

Units: ms 

Applicable 
Operating 
Mode: 

All 

When Enabled Servo-Off  -> Setting 

 
The following statuses are displayed by default for an CSD5 Drive in the 
Digital Outputs window: 
 

Output 1~6 State 

The current state, or condition, of each digital output is 
depicted by a light bulb icon, as follows: 
ON - a bright light bulb 
OFF - a darkened light bulb. 

 
No Special commands are associated with the Digital Outputs window. 
 
Customize the Digital Outputs window for your CSD5 Drive branch by 
selecting one or more of the following buttons: 

• Toggle the Show Status selection to display or hide the Status pane. 

• Toggle the Show Commands selection to display or hide the 
Commands pane. 

• Click on the Setup button to open the Monitor Setup window as shown 
on page 112, where you can customize the status display for this window. 

• Click on the Revert button to return parameter settings to the values 
they held when you opened this window. 

The Properties window for Analog Outputs looks like this: 
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Use the Analog Outputs window to assign drive signals to analog outputs. 
 
The Analog Outputs parameters window has the following parameters: 
 

Description The drive signal assigned to channel 1 from the Channel Setup dialog box in the Oscilloscope window. 

Parameter [Ft-5.13], [Ft-5.14] 

Range: 

Select Description Value 

Motor Feedback Position Motor Feedback Position 1~99999[count/V] 

Master Position Master Position 1~99999[count/V] 

Follower Position Follower Position 1~99999[count/V] 

Position Error Position Error 1~99999[count/V] 

Position Command Count 
Frequency 

Position Command Count 
Frequency 

0.1~9999.9[kilocount/V] 

Velocity Command Velocity Command 1~99999[RPM/V] 

Velocity Feedback Velocity Feedback 1~99999[RPM/V] 

Velocity Error Velocity Error 1~99999[RPM/V] 

Current Command Current Command changeable with motor type[%/V] 

Current Feedback Current Feedback changeable with motor type[%/V] 

U Phase Current U Phase Current changeable with motor type[%/V] 

V Phase Current V Phase Current changeable with motor type[%/V] 

W Phase Current W Phase Current changeable with motor type[%/V] 

Commutation Angle Commutation Angle 0.1~9999.9[°/V] 

Mechanical Angle Mechanical Angle 0.1~9999.9[°/V] 

Shunt Power Limit Ratio Shunt Power Limit Ratio 1~99999[%/V] 

Instantaneous Shunt Power Instantaneous Shunt Power 1~99999[W/V] 

Drive Utilization Drive Utilization 1~99999[%/V] 

Absolute Rotations Absolute Rotations 1~99999[revolution/V] 

Bus Voltage Bus Voltage 1~99999[V/V] 

Velocity Command Offset Velocity Command Offset 0.1~9999.9[mV/V] 

Current Command Offset Current Command Offset 0.1~9999.9[mV/V] 

Motor Utilization Motor Utilization 1~99999[%/V] 

Analog Command - Velocity Analog Command - Velocity 0.01~999.99[V/V] 

Analog Command - Current Analog Command - Current 0.01~999.99[V/V] 

Default: Velocity Feedback 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

Description The amplitude of  the channel 1 input signal to be displayed by the oscilloscope. 
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Parameter [Ft-5.15], [Ft-5.16] 

Range: 1 ~ 99999 

Default: 500 

Units: Units depend on the channel selection. 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

No status is displayed for an CSD5 drive in the Analog Outputs window. 
No Special commands are associated with the Analog Outputs window. 
 
Customize the Analog Outputs window for your CSD5 Drive branch by 
selecting one or more of the following buttons: 

• Toggle the Show Status selection to display or hide the Status pane. 

• Toggle the Show Commands selection to display or hide the 
Commands pane. 

• Click on the Setup button to open the Monitor Setup window as shown 
on page 112, where you can customize the status display for this window. 

• Click on the Revert button to return parameter settings to the values 
they held when you opened this window. 

RSWare's Monitor tool lets you select and display all or any combination of 
drive statuses for a selected CSD5 on-line drive. The Monitor tool works just 
like the status pane of a branch's Properties window. 
 
Use this window to: 

• View a collection of statuses. 

• Open the Monitor Setup window, where you can select the collection of 
statuses to display in this window. 

• Load a monitor previously saved. 

• Save a monitor for later use. 

This window has the following commands: 
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Format 

Select the format for displaying integer values in the monitor: 
•Decimal(Range: 0 to 2147483647) 
•Hexadecimal, or 
•Binary 
Note: Do not create negative numbers in the Hexadecimal 
or Binary format. 

Load 

Opens the Monitor Load dialog, where you can: 
•Load a previously saved monitor from the list. 
•Delete an existing monitor from the list. 
•Save as de fault an existing monitor to automatically load each 
time you open the Monitor window. 

Save 

Opens the Monitor Save dialog, where you can: 
•Save a monitor, under a new or existing name, for later use. 
•Delete an existing monitor from the list. 
•Save as de fault an existing monitor to automatically load each 
time you open the Monitor window. 

Setup 
Opens the Monitor Setup window, where you can select the drive 
statuses that is displayed in this window. 

 
To monitor your drives: 

1. Double-click the left mouse button on the Monitor icon in the Workspace 
window. The Monitor window appears in the Client Area. 

2. Click the Setup… button to open the Monitor Setup window, where you 
can customize the display of the Monitor window for the selected on-line 
CSD5 drive. The window displays a tree diagram with all the statuses that 
can be monitored for the selected drive. 

3. Place a check mark in the checkbox to the left of a status item to monitor 
it. Note: 

• If you place a check mark beside a parent item, all its child items become 
checked and their statuses are displayed. 

• If you remove a check mark from a parent item, check marks are 
removed from all its child items and their statuses are not displayed 

• If you place a check mark next to some - but not all – child items, the 
parent item is checked, but grayed. 

Note: The Properties window for Motor Setup of KNX3 and CSD5 are 
different. The below is an illustration of CSD5 Drive. 
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4. After you have finished selecting the statuses you wish to monitor, select 
OK to close the Monitor Setup window 

5. The Monitor window now displays all the selected statuses: 

 

The Properties window for the Oscilloscope looks like this 
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Note: The Properties window for the Oscilloscope of CSD5 Drive and KNX3 
Drive are not same. The below is an illustration of CSD5 Drive. 

 

 
 

Use the Oscilloscope window to trace one of two drive signals by: 

• Configuring the oscilloscope by selecting a drive signal to trace. 

• Executing commands that run the oscilloscope's tracing function 
continuously or in response to the configured trigger. 

• Monitoring the oscilloscope as it traces the selected drive signal. 

The Oscilloscope window has the following parameters and commands 
associated with it: 
 

Description 

Signal Select a drive signal to assign to the selected Channel (A,B) from the Channel Setup dialog box that 
opens when you click on the down arrow to the right of  this input box. 
Note: The resolution of  this signal may be confusing if  Velocity Feedback is selected. See the topic Velocity 
Motor Feedback Resolution for information on how is derived for various motor and feedback combinations. 

Parameter - 

Range: 

Select Description Value 

Motor Feedback Position Motor Feedback Position 1~99999[count/V] 

Master Position Master Position 1~99999[count/V] 

Follower Position Follower Position 1~99999[count/V] 

Position Error Position Error 1~99999[count/V] 

Position Command Count 
Frequency 

Position Command Count 
Frequency 

0.1~9999.9[kilocount/V] 

Velocity Command Velocity Command 1~99999[RPM/V] 

Velocity Feedback Velocity Feedback 1~99999[RPM/V] 

Velocity Error Velocity Error 1~99999[RPM/V] 

Current Command Current Command changeable with motor type[%/V] 

Current Feedback Current Feedback changeable with motor type[%/V] 
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U Phase Current U Phase Current changeable with motor type[%/V] 

V Phase Current V Phase Current changeable with motor type[%/V] 

W Phase Current W Phase Current changeable with motor type[%/V] 

Commutation Angle Commutation Angle 0.1~9999.9[°/V] 

Mechanical Angle Mechanical Angle 0.1~9999.9[°/V] 

Shunt Power Limit Ratio Shunt Power Limit Ratio 1~99999[%/V] 

Instantaneous Shunt Power Instantaneous Shunt Power 1~99999[W/V] 

Drive Utilization Drive Utilization 1~99999[%/V] 

Absolute Rotations Absolute Rotations 1~99999[revolution/V] 

Bus Voltage Bus Voltage 1~99999[V/V] 

Velocity Command Offset Velocity Command Offset 0.1~9999.9[mV/V] 

Current Command Offset Current Command Offset 0.1~9999.9[mV/V] 

Motor Utilization Motor Utilization 1~99999[%/V] 

Analog Command - Velocity Analog Command - Velocity 0.01~999.99[V/V] 

Analog Command - Current Analog Command - Current 0.01~999.99[V/V] 

Digital I/O Digital I/O 

bit 0 Digital Input 1 

bit 1 Digital Input 2 

bit 2 Digital Input 3 

bit 3 Digital Input 4 

bit 4 Digital Input 5 

bit 5 Digital Input 6 

bit 6 Digital Input 7 

bit 7 Digital Input 8 

bit 8 Digital Input 9 

bit 9 Digital Input 10 

bit 10 Estop 

bit 11 Digital Output 1 

bit 12 Digital Output 2 

bit 13 Digital Output 3 

bit 14 Fault 

bit 15 
Digital Output 4 / 
Fault 1 

bit 16 
Digital Output 5 / 
Fault 2 

bit 17 
Digital Output 6 / 
Fault 3 

Default: Velocity Feedback 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

Description Select the division scale and offset setting 

Parameter - 

Range: 

Select Description Value 

Auto 
The division scale and offset 
are changed automatically 

- 

Manual 
The division scale and offset 
are set manually 

- 

Default: Auto 
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Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

Description 

The amplitude of  the selected channel input signal that can be displayed between gridlines of  the oscilloscope, 
in the units of  the drive signal. It is dependent on the signal selected. If  the Scale is left at its default value of  
0, RSWare auto scales the data to fit the graph. 
Note: Visible only if  Scale Type is Manual. 

Parameter [Ft-5.13], [Ft-5.14] 

Range: 1 ~ 99999 

Default: 0 

Units: Units depend on the channel selection. 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

Description 

The trace offset for the selected Channel Input. Its range depends on the signal selected. A value of  zero 
places the zero value of  the signal at the middle grid line. A nonzero offset shifts the trace up or down so that 
the offset value is positioned at the middle grid line. 
Note: Visible only if  Scale Type is Manual. 

Parameter [Ft-5.15], [Ft-5.16] 

Range: 1~99999 

Default: 0 

Units: Units depend on the channel selection. 

Applicable 
Operating 
Mode: 

All 

When Enabled Immediately 

 

Y-axis Labels  

Labels Select which labels to display on the y-axis: 
•Default: One reference point for each channel is displayed. 
•Channel A 
•Channel B 

Legend 
The legend displays the color of the trace for each displayed input 
signal. The colors can be modified by clicking on the color 
rectangles displayed in the legend 

 
The following commands can be executed for the Oscilloscope window of an 
on-line drive: 
 

Arm Trigger Turns the oscilloscope trigger ON. 

Run Continuous Runs the oscilloscope continuously, circumventing the trigger 

Stop Triggering Turns the oscilloscope trigger OFF. 

Snap Shot Show the a set of data in Snap Shot Dialog 

 
Customize the Oscilloscope window for your CSD5 Drive branch by selecting 
one or more of the following buttons: 
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• Toggle the Show Properties selection to display or hide the Properties 
pane. 

• Toggle the Show Commands selection to display or hide the 
Commands pane. 

• Click on the Save button to save the oscilloscope data to a tab delimited 
file on your PC, which can be read by spreadsheet or presentation 
software. Information saved includes the Oscilloscope data points from 
one or more channels. 

• Click on the Revert button to return parameter settings to the values 
they held when you opened this window. 

 
 
Note: Digital I/O option is added only for CSD5. 
 
Use this window to: 

• Assign a specific Input Signal to the selected Channel in the Oscilloscope 
window for an CSD5 drive, or 

• Assign no Input Signal to the selected channel in the Oscilloscope 

window for an CSD5 drive. 

Much like the Monitor window, this window allows you to customize the 
display for the selected on-line CSD5 drive. The window displays a tree 
diagram with all the statuses that can be monitored for the selected drive. 

 
To assign a specific input signal, or status, to the selected channel: 

1. Open the tree control to the desired branch by clicking on one or more + 
(plus) signs. 

2. Place a check mark in the box next to the desired input signal, or status. 
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3. Click OK. The selected input signal appears in the selected Channel in the 
Oscilloscope window. 

To assign no input signal, or status, to the selected channel: 

1. Be sure no check marks appear next to any input signal, or status. 

2. Click OK. The word Unassigned appears in the selected Channel in 
the Oscilloscope window. 

The Properties window for the Faults display looks like this: 

 
Note: The Properties window for Faults of CSD5 Drive and KNX3 Drive are 
not same. The below is an illustration of CSD5 Drive. (Status 24 is deleted, 
Status 25, 86, 104 are added for KNX3 Drive.) 
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Use the Faults window to: 

• Set fault limits 

• Monitor fault statuses 

• Execute the Clear Faults command 

• Open a window where you can review the drive's fault history 

The Faults window has the following parameters, statuses and commands 
associated with it: 
 

Description The minimum position error which triggers the Following Error fault. 
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Parameter [Ft-5.10] 

Range: 0~2,147,483,647 

Default: 99999 

Units: Counts 

Applicable 
Operating 
Mode: 

Follower 

When Enabled Immediately 

Description The AC Line Loss Fault is inhibited for this amount of  time, when a loss of  AC power is detected. 

Parameter [Ft-5.12] 

Range: 20~1000 

Default: 20 

Units: ms 

Applicable 
Operating 
Mode: 

All 

When Enabled Servo-Off  -> Setting 

 
The Faults window displays the status of the following faults: 
 
Note: Status 24 is deleted, Status 25, 86, 104 are added for KNX3 Drive. 
 

4: Motor 
Overtemperature 
Fault 

Motor thermal switch trips due to: 
•High motor ambient temperature, and 
/or 
•Excessive current 

• Operate within the continuous torque rating (not exceeding) 
according to the ambient temperature. 
• Lower the ambient temperature or increase the motor cooling. 

Motor wiring error •Check the wiring of the motor. 

Unsuitable motor selection •Check if the motor selected is suitable. 

5: IPM Fault 

Motor cable shorted 
•Check if the motor power cable and the connector are not 
shorted. 

Occurs when the winding wire of the 
motor is shorted internally. 

Disconnect the motor power cable from the motor. If the motor 
will not be rotated by hand, a replacement may be needed. 

Occurs when exceeding the continuous 
power rating while operating. 

•Check if the ambient temperature is too high. 
•Operate within the continuous power rating. 
•Decrease the acceleration rate. 

Occurs when an unsuitable IPM 
output, short circuit or overcurrent 
exist in the drive. 

•Check the wiring connections that go from U, V, and W motor 
terminals to the DC BUS after disconnecting the power and the 
motor. If the connections are normal, check the wires between 
terminals or have the drive repaired. 

9: Bus 
Undervoltage Fault 

AC line/AC power input is low. 
•Check the voltage level of the incoming AC power. 
•Check the noise pulse of the AC power or for a voltage drop. 
•Install an Uninterruptible Power Supply (UPS) to the AC input. 

Attempted to activate the drive without 
turning on 
the main power. 

•Before activating the drive, turn on the main power. 

10: Bus 
Overvoltage Fault 

Occurs when the power regeneration is 
excessive. 
That is, the drive generates an error to 
protect itself from the overload when 
its main power supply regenerates 
excessive peak energy while the motor 

•Increase the time assigned in Homing Time Limit (IN-01.11). 
•Set the value other than '0' in Homing Velcoity(IN-01.02) and 
Creep Velcoity(IN-01.03). 
•Check for an obstruction in homing. 
•Check the homing related parameter setting and mechanical 
parts. 
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is run by the external mechanical 
power. 

Excessive AC input voltage •Check the specifications of the input. 

12: Home Search 
Failed 

Homing is incomplete within the time 
assigned in 
Homing Time Limit (IN-01.11). 

•Increase the time assigned in Homing Time Limit (IN-01.11). 
•Set the value other than '0' in Homing Velocity (IN-01.02) and 
Creep Velocity (IN-01.03). 
•Check for an obstruction in homing. 
•Check the homing related parameter setting and mechanical 
parts. 

18: Motor 
Overspeed Fault 

Motor speed exceeds the maximum. 

•Check the wiring of the encoder. 
•Retune the drive system. 
•Check the input gain of the torque or the external speed 
command. 

19: Excess Position 
Error Fault 

Occurs when the position error exceeds 
the allowed value. 

•Increase the Following Error Limit value. 
•Check the position loop tuning. 

22: Motor 
Continuous 
Current Overload 
Fault 

Occurs when the internal filter that 
protects the motor from overheating 
trips. 

•Decrease the acceleration rate. 
•Decrease the duty cycle (ON/OFF) of the motion assigned. 
•Increase the time for the motion allowed. 
•Use a drive or motor with bigger capacity. 
•Check the tuning. 

23: Drive Overload 
Fault 

Occurs when the drive average current 
exceeding the rated capacity is needed 
for the motion application. 

•Decrease the acceleration rate. 
•Decrease the duty cycle (ON/OFF) of the motion assigned. 
•Increase the time for the motion allowed. 
•Use a drive or motor with bigger capacity.  
•Check the tuning. 

24: Absolute 
Position Transfer 
Timeout Fault 

Position Strobe input is not turned 
on/off within 5s from the rising/falling 
edge of Absolute Position Transfer 
Ready during Absolute Position 
Transfer Mode using photo coupler 
output.  
Absolute Position Transfer Mode input 
is not turned off within 5s after 
absolute data transfer completion 

•Verify the sequential timing of Position Strobe & Absolute 
Position Transfer Mode input.  
•Verify continuity of I/O cable and connector. 

25: Sensor 
Unassigned 

The sensor (H_SENS, P-OT, N-OT) 
used in a selected Homing Type is 
not configured at the Digital Input. 

•Configure the sensor to use in a selected Homing Type at the 
Digital Input. 
•Select a Homing Type in which a sensor (H_SENS, P-OT, N-
OT) is not used. 

27: Axis Not 
Homed 

Occurs when an axis didn't return to 
home before the drive can operate an 
absolute coordinate index. 

•Define the Home position 

28: Encoder Data 
Range Fault 

Occurs when the encoder is not 
properly programmed. 

•Replace the motor. 
Occurs when the memory of the 
encoder is damaged. 

30: Encoder Cable 
Open Fault 

Occurs when the communication with 
the interactive encoder cannot be 
established. 

•Check the motor selected. 
•Check whether the motor supports an auto-detection. 
•Check the wiring of the encoder. 

Hall Error 

31: Encoder Data 
Parameter Fault 

Occurs when the encoder is not 
properly programmed. 

•Replace the motor. 

  
Occurs when the memory of the 
encoder is damaged. 
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36: Drive 
Overtemperature 
Fault 

Occurs when the drive overheats. 

•Check if the cooling pan is working 
•Check the tuning. 
•Decrease the acceleration rate. 
•Decrease the duty cycle (ON/OFF) of the motion assigned. 
•Increase the time for the motion allowed. 
•Use a drive or motor with bigger capacity. 

37: AC Line Loss 
Fault 

Occurs when the power is low. •Increase the instant outage compensation time. 

Attempted to activate the drive without 
turning on the main power. 

•Before activating the drive, turn on the main power. 

A phase is not connected. •Disconnect the power and check all mechanical connections. 

The alarm delay parameter is set too 
short. 

•Increase the Alarm delay parameter value. 

53: User Parameter 
Initialization Fault 

An error exists in the parameter saved 
in the memory. 

•Initialize the parameter. 
•Reset the values of the drive to the factory settings. 

54: Current 
Feedback Offset 
Fault 

Defective Hardware •Replace the drive. 

55: User Parameter 
Checksum Fault 

Checksum Error 
•Check the parameter and reset. 
•Reset the values of the drive to the factory settings. 

56: Watchdog 
Timeout Fault 

Excessive System Noise •Check the wiring and the installation method. 

Defective Hardware •Replace the drive. 

57: PWM 
Hardware Fault 

Defective Hardware •Contact your nearest dealer. 

58: User Parameter 
Range Fault 

Parameter range is invalid. 
•Input the parameter within the range. 
•Reset the values of the drive to the factory settings. 

60: Drive 
Initialization Fault 

Hardware Error •Replace the drive. 

75: Shunt Overload 
Protection Fault 

Exceeds the value allowed by the 
voltage of the regeneration resistance. 

•Adjust the motion profile and keep the regeneration resistance 
within the limit. 

Regeneration resistance is separated or 
damaged. 

•Check the connection of the regeneration resistance. 
•Check the values of the regeneration resistance. 

79: Shunt 
Overcurrent 
Protection Fault 

The regenerative current exceeds the 
allowable instant value. 

•Check if the regeneration resistance is shorted or damaged. 
•Check if the overload energy is excessive while decelerating. 

83: Absolute 
Encoder Battery 
Fault 

The constant of the encoder backup 
battery is set as 'installed,' but the 
battery is not installed. 

•Set the constant of the encoder backup battery as 'not installed.' 

The battery voltage is detected under 
2.7 V dc. 

•Check the battery voltage and the connections. 
•Replace the battery. 

84: Absolute 
Encoder 
Overspeed 

The encoder rotates mechanically at 
high speed while turning off the drive, 
when it is powered by the battery. 

•Remove the motor from the system. 
•Turn off and on the drive and reset the Warning. 

85: Absolute 
Encoder Multi-turn 
Count Fault 

Noise from Encoder •Turn off and on the drive and reset the Warning. 

Defective Encoder •Replace the motor. 

86: Encoder Single-
turn Count Fault 

Noise in the encoder 
Defective encoder 

•Cycle power to drive and reset alarm. 
•Replace motor. 

100: Drive Set Up 
Fault 

The drive operation mode and the 
motor selection are not compatible. 

•Change the operation mode and/or motor selection, and reset 
the drive. 

101: Motor Power 
Cable Open Fault 

The motor cable is not connected. •Check the power connection between the motor and the drive. 

102: Motor 
Instantaneous 

Current Overload 
Fault 

The motion profile requires peak 
current for a lengthy time. 

•Check the wiring of the motor. 
•Adjust the acceleration/deceleration time. 
•Check if the motor selected is suitable. 

There is a defect in the current 
feedback detection. 

•Check the phase current. 

103: Motor 
Mismatch Fault 

The dynamic control current of the 
selected motor exceeds double the 
value of the drive peak current rating. 

•Install a different motor. 
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104 : Continuous 
Power Overload 
Fault 

Motion application requires average 
drive power in excess of rated 
capability 

•Reduce acceleration rates. 
•Reduce duty cycle (ON/OFF) of commanded motion. 
•Increase time permitted for motion. 
•Use larger drive and motor. 
•Check tuning. 

105: Encoder Type 
Mismatch Fault 

The motor encoder signal does not 
match the drive configuration. 

•Check the motor selected. 

Defective Encoder •Replace the motor. 

106: Encoder 
Communication 
Fault 

The wiring between the drive and the 
encoder is cut off or problematic. Or 
encoder signals are interrupted by the 
EMI (noise). 

•Check the wiring of the encoder. 
•Contact your nearest dealer. 

107: Serial 
Communication 
Fault 

Communication error between the host 
and the drive (noise) 

•Check the serial communication cable. 
•Check the noise of the serial communication interface. 

108: Position 
Command 
Frequency Fault 

The input frequency value exceeds the 
limit. 

•Check if the hardware type selected in the drive matches the 
physical hardware. 
•Change from an open collector to a line drive. 
•Decrease the speed command. 
•Manipulate the gear. 

112: Emergency 
Stop 

Emergency Stop (E-STOP) is detected. 
•Remove the emergency stop condition. 
•Erase E-STOP signal. 

113: Indexing 
Position Range 
Overflow 

The constant of the index position 
deviates the range. 

•Use a value in the range between -2,147,483,647 ~ 
+2,147,483,647. 

114: Motor Phase 
Over Current 

•When the error occurs while turning 
on the power, there is a problem in the 
control or main power circuit. 
 •When this error occurs while in 
operation, overcurrent exists. (current 
that is 300% over the rated current is 
supplied to the motor at more than 250 
ms.) 

•Check the wiring and the power. 
•Check the power and set or adjust the acceleration/deceleration 
time. 

BAT: Warning: 
Absolute Encoder 
Battery 

It occurs when the voltage of external 
battery of absolute encoder is 3.2 [V] or 
less. 

• Replace the battery. 

CNT: Warning: 
Absolute Encoder 
Count Overflow 

In the event the Q, E Type Absolute 
Encoder is rotated forward or reverse 
over 32768 (H,J Type Absolute 
Encoder is for 4096) revolution, it is 
displayed. 

•Reset the Absolute Encoder. 

OCC: Warning: 
Over Current 
Command 

When the external torque command is 
inputted with 300 [%] or more of the 
rated value, it is displayed. 

•When the torque command is inputted for 300 [%] or more of 
the rated value, the drive is automatically limited at 300 [%]. Also, 
when lowering the external torque command to 300 [%] or less 
of the rated value, it automatically disassembled. 

OSC: Warning: 
Over Speed 
Command 

When the external speed command is 
inputted with the maximum speed or 
more of the motor, it is displayed. 

•When the speed command is inputted with the maximum speed 
or more of the motor, the drive is automatically limited at the 
maximum speed of motor. Also, when the external speed 
command is lowered for less than the maximum speed or less of 
the motor, it automatically disassembled 

PIN: Warning: 
Digital IO 
Assignment 

When sequence input & output signal is 
duplicated and allotted to the same 
input and output channel. 
In mixed control mode, when the 
control mode conversion </C-SEL> 
sequence input signal is not allotted. 
In multi-step control mode, when 
speed command </C-DIR>,</C-
SP1>, </C-SP2>, </C-SP3> sequence 
input signal is not allotted, it is 

•Resetting sequence input & output signal. After resetting, it is 
effective only when the power is re-allowed. 
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displayed. 

PRE: Warning: 
Power Up 
Overspeed 

There may be a time of motor rotating 
for over 100[RPM] when main power is 
ON. 

•It only occurs in the event of Absolute Encoder serial of Q, E 
Type. And when the resolution of 1 rotation data is 17bit, it 
automatically disassembled. 

PRE: Warning: 
Power Up 
Overspeed 

It occurs when motor power is set 
higher than the drive rated output. 

•Use a motor suitable to the drive or set the torque limit below 
the drive capacity. 

 
Customize the Faults window for your CSD5 Drive branch by selecting one or 
more of the following buttons: 

• Toggle the Show Status selection to display or hide the Status pane. 

• Toggle the Show Commands selection to display or hide the 
Commands pane. 

• Click on the Setup button to open the Monitor Setup window, where 
you can customize the status display for this window. 

• Click on the Revert button to return parameter settings to the values 
they held when you opened this window. 

The Service Information window looks like this: 

 
 
Use the Service Information window to: 

• Display and monitor service information about the drive. 

• Display the firmware version of the drive. 

The following statuses apply to the Service Information window: 
 

Drive Model  
The model number of the drive. This is the number you 
selected from the Select New Drive dialog after executing the 
Insert CSD5 command. 
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The following statuses apply to the Service Information window: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Customize the Service Information window for your CSD5 Drive branch by 
selecting one or more of the following buttons: 

• Toggle the Show Status selection to display or hide the Status pane. 

• Toggle the Show Commands selection to display or hide the 
Commands pane. 

• Click on the Revert button to return parameter settings to the values 
they held when you opened this window. 

  

Status Description 

Drive Model  
The model number of the drive. This is the number you 
selected from the Select New Drive dialog after executing the 
Insert CSD5 command. 

Firmware Version 

The version of the selected On-Line drive's firmware in the 
format XX.YY, where: 
XX = major revision 
YY = minor revision 

CPLD Version 

The version of the selected On-Line drive's CPLD in the
format X.YY, where: 
X = major revision 
YY = minor revision 
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